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Review Celleste features and
functionality

Objectives :
 Familiarity with Celleste” Layout and features

¢ Open an Image

Familiarize yourself with the Celleste " layout and features.

Open Celleste " 5.0.

1. From the View ribbon select Tools, Reset Tools Layout.

2. From the File menu select Open, Open Images, select and open the file
“Hela_10x_a_DAPLtif” from the folder “Blue Nuclei Staining”. You will see the
layout shown below.

What do you see in the status bar when you move the cursor over the image?
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

3. Open the Celleste " online help from the menu on the top right.

4. Look at the tab and ribbons of tools. Select the Count/Size tab. Tools are arranged
in functional groups. Place the cursor in the bottom right hand corner of a group
of tools to get access to context related online help. Show the online help for the
Measurements group.
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

5. Select the measurements options from the Count/Size tab.

The measurements details dialog is shown by default in the details panel on the
right-hand side of the application. The options button is greyed to show the
panel is being selected.

6. Close the measurements details panel by pressing the measurements option

button again to de-select it. Open it again and close it by selecting the close
button in the dialog’s top right-hand corner.
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

7. Re-open the Measurement details panel and undock it by dragging its title bar
out of the details panel. You now have a floating panel.

8. Re-dock the panel on the left hand side of the application.
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

9. If you build a layout that you find helpful, you can save it from the View menu
by selecting Tools, Save Layout. Select Tools, Reset Tools Layout.

10. Select the Process tab. Right click on the tools ribbon. The option to either show
or hide groups of tools is set in the “Show or Hide Groups dialog” that appears.
Show the “Filters” group and select the 2D filters. Keep in mind that tools can be
hidden in order to simplify the layout of Celleste .

11. Click on the select tab and show the features group. Select the Features manager.

12. Click on the count/size tab and select the measurements options.
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

13. You can choose between multiply selected and shown dialogs by switching

14.

15.

between the tabs at the bottom of the details panel. Switch between the three
dialogs.

De-select the Features manager by either selecting its tab and the bottom of the
details panel and clicking the close button in the top right, or de-select the
Features manager button on the Select ribbon.

Open the scan.2017-12-15-11-10-46-40x 0.95 image set located in the
scan.2017-12-15-11-10-46-40x 0.95 Stack folder on the image desktop.

Select and R image with z information and turn on the Group Related Files
option. Press the Open button to load the image stack.
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

16. Ensure that Image is selected from the Image Ribbon.

17. Deselect the composite view.

18. With the color composite view disabled the channel can be selected using the
Image Set Navigation tool.

19. Re-select the color composite view. What happens to the Channel dimension of
the image set navigation? Why?

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 1 Review Celleste™ features and functionality
Familiarize yourself with the Celleste™ layout and features.

20. Select the 3D rendering view. What happens to the Z dimension in the Image Set
Navigation? Why?

21. Reselect the Image View from the Image Ribbon.

22. Move your cursor into the navigation slider on the left of the image set
navigation tool. De-select the first three z planes.

23. Do the same on the right hand side to de-select the last three Z planes.

24. Select the Crop tool from the select ribbon.
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Work with Regions of Interest (ROI)

Objectives:

Create ROIs

Learn how to create a single ROI and multiple ROls.
Create a calibrated ROL

Use the XOR and other special ROI modes.

Use the Features Manager to save ROIs and recall them.

Learn to reload ROIs from the Features Manager and change the overlay type.

. Open the ” 01.zc_60X_04.21.2016.png” image by selecting the File Tab,

Open/Open Demo Images menu and browse to the IHC images folder.

Choose the Select Tab.

In the Region of Interest group box, select the Green Select ROI Polygon tool
Button and draw an ROI on the image as shown below.

Selecting a Polygon ROI
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Chapter 2 Work with Regions of Interest (ROI)
Create ROIs

Polygon ROI

4. Select the ROI Options Button and check the ROI Mask option. The ROI Mask
option allows you to clearly display where the ROI is currently active.

ROl Mask Option
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Chapter 2 Work with Regions of Interest (ROI)
Create ROIs

Active ROI
5. There are two primary options available when changing how ROIs behave, the

first one is Invert ROI'’s. Toggle the Invert ROI Button and see the results. The
active area is now outside the polygon.

Toggle the Invert ROI off before proceeding to Step 6.

Invert ROl Options

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 2 Work with Regions of Interest (ROI)
Create ROIs

Inverted ROI

6. The second major option in the ROI Options is to create a “donut” ROI using the
XOR option. However, you will need two ROIs.

XOR ROI Button
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Chapter 2 Work with Regions of Interest (ROI)
Create ROIs

7. When done, delete all ROIs on the image by pressing the Red XX Button in the
Region of Interest group box.

Delete All ROIs Button

8. Turn on the Multiple ROIs Button in the Regions of Interest Group Box as shown
below. With the Multiple ROIs option active, you may draw multiple ROIs on the

image.

Multiple ROIs Button

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 2 Work with Regions of Interest (ROI)
Create ROIs

9. Select the Polygon ROI Tool.

Polygon Tool

10. Draw multiple Polygon ROIs on the image covering the structures as shown
below. It is not necessary to display the ROI Mask and is only shown as

indication of the active ROI areas.

Multiple ROIs
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Chapter 2 Work with Regions of Interest (ROI)
(Optional) Create a calibrated RO/

[Optional] Create a calibrated ROI

1. Using the calibrated Imagel 4x.jpg image from Appendix B, “Calibrate an
image”, select the drop down attached to the ROI by Number button. Tick the
check box “In Calibrated Units”, which will allow positions to be entered in as
calibrated units.

2. Create a 1000 square mm box on the image at any location by entering in the
appropriate values. Press the ROI by Numbers Button to apply the ROL

Note: The ROl is defined by the corners of the ROI as shown in the follow screen
shot.

Creating A Calibrated ROI

3. Delete the ROI by press the double red X button in the Regions of Interest group.
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Chapter 2 Work with Regions of Interest (ROI)
Use Features Manager

Use Features Manager

1. Select the open 01.zc_60X_04.21.2016.png image and make it the active image.

Active Image
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Chapter 2 Work with Regions of Interest (ROI)
Use Features Manager

2. The Features Manager tool is not displayed by default. The Features Manager
Group will be displayed by right mouse clicking in the Select Ribbon and
selecting the Features icon.

Show Features Manager

3. Press the Features Manager Button to open the Features Manager Panel.

Features Manager Button

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 2 Work with Regions of Interest (ROI)
Use Features Manager

4. In the Features Manager Panel, use the Add All Button to create a list of ROIs in
the Features Manager.

Add ROls to a Collection
5. When done, delete all ROIs on the image.
6. By pressing the widget, you can view the collection name and all of the

individual ROIs. The name of the collection may be changed by typing in a new
name.

List Of ROIs In A Collection
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Chapter 2 Work with Regions of Interest (ROI)
Use Features Manager

7. Transfer one or more or all ROIs to any image of the same size and calibration by
pressing the “Set Object to Image” Button(s).

Set Object To Image Button
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Objectives:

Show and hide the plate
Select the displayed well

Use the plate viewer.

viewer

Set the active range of plates for image processing and deconvolution

Crop plates
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Chapter 3 Use the plate viewer.
Use the plate viewer

Use the plate viewer

The plate viewer supports 6, 12, 24, 48, 96, 384, 1536 well plates:

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 3 Use the plate viewer.
Use the plate viewer

1. Open one of the Raw Images from the “Live Dead” dataset. Ensure group related
files is selected.

The dataset will open with the plate viewer displayed in the details panel on the
right of the application.

2. Toggle the visibility of the Plate Viewer using the button in the image set
navigation toolbar.

Populated and active wells are displayed in blue.
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Chapter 3 Use the plate viewer.
Use the plate viewer

Empty wells are displayed in grey. [ ]
The active (currently selected well) is displayed in red.

3. Set the contrast using the Color Composite Controls. It may be helpful to hide all
channels except the channel you're working on. You have the choice of using the
histogram, brightness, contrast and gamma, or best fit tools (or combination of
these tools). Any enhancements that you make will affect the whole plate. This
has the advantage of making visual comparisons between different treatments
meaningful.

4. Change the active well by clicking on another populated well. The change that
you make is reflected in the image workspace and the Image Set Navigation
toolbar.

5. Change the active well in the Image Set Navigation tool bar. The change will be
reflected on the plate viewer.
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Chapter 3 Use the plate viewer.
Use the plate viewer

6. Set an active range of wells by drag selecting from well Al (start the drag inside
the well) to A12.

Populated but inactive wells are displayed in light blue. [ ]
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Chapter 3 Use the plate viewer.
Use the plate viewer

7. From the Process tab select the 2D filers. From the edge filters select the variance
filters. Ensure that the option to apply to a new image is not selected before
Clicking “Apply”. Use the plate viewer to compare the images from row A with
the rest of the plate.

8. Click undo to restore all images to their original appearance.

9. Re-set the active range to row A.
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Chapter 3 Use the plate viewer.
Use the plate viewer

10. Select the 2D filters dialog and ensure that the option to apply to a new image is
selected before clicking apply. What happens?

11. Select the original dataset.

12. Click the top left hand side of the Plate Viewer to reactivate all of the wells.

13. Hold down the Ctrl key and click on the letter C of the plate viewer, keep the Ctrl
pressed and click on the number 2 of the Plate Viewer. What does this do?

14. Set the active range to rows A and B.

15. Click on the “Select” tab. Click on Crop in the clipboard group. What happens?
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Chapter 3 Use the plate viewer.
Use the plate viewer

16. From the File menu, select the application options. Select the “Image” options
and de-select Auto tile.

17. Re-open the live / dead dataset. How does it differ from the first time that you
opened it?

Introduction to Celleste™ Imaging Analysis Software User Guide
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Count objects and cells

Objectives:

Understand the workflow for setting up an automated image analysis using
monochrome or color images.

Learn how to add feature measurement types and use various measurement
parameters to include or exclude areas or objects.

Learn how to test the various Count/Size parameters and settings to develop a
successful image analysis workflow.

Learn about setting and saving the Count and Size Options for later use in
another experiment or in a macro.

Develop an image analysis Workflow/Protocol

Typical Steps:

1.

10.

1.

34

If you are starting a new workflow, it is a good practice to reset all Count/Size
options.

Preform image preprocessing if required for the analysis.

Segment the image and adjust the segmentation as needed. The objects or cells
should be named in the Segmentation/Threshold dialog box.

Press the Count Button and analyze the image.
Select the Measurement Types to be used in the analysis.

Use the Edit Ranges tool to remove areas/objects which should not be in the
analysis.

If objects need to be split automatically, test and set the object splitting options.
The Split with Count option should be set to accurately analyze the image.

Use the Measurement Options to set the segmentation and appearance options.
Format the data in the Data Table.
Delete the count and recount to test the protocol. Adjust the protocol as needed.

Save the settings (Measurement Options .iqo file).
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Count cells in a monochrome image

1. Open the ” A549_0.6um_Live_Dead_NBL_10X_Plate_R_p0_0_D07f00d0.TIF”
image from the Celleste” Demo Images

\Live_Dead_Cell_Imaging_Kit_SKUR37601_and_NucBlue"Live_SKUR37605
\A549\ A549_0.6um_Live_Dead_NBL_10X.2017-02-08-17-48-35 folder.
The image is a NucBlue " Live labeled nuclei.

2. Select the Count and Size tab.

3. Press the Measurements and Class Reset Buttons to clear any old values.

Reset Button

4. In the Segment group, click the Bright Button to auto-segment bright objects.

Adjust the threshold by selecting the slider in the histogram to select all of the
nuclei if necessary.

Segment Group

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Threshold Tool

5. Replace the name “Class 1” by highlighting the text and entering the text “Cells”.

Note: The Class Name will now be reported in the Data Table when the results
are generated if the Class Name Feature Type is active.
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Threshold Class Naming

6. Press the Count Button to get an initial cell count.

Note: If the number of counted objects is different than the number of
segmented objects, other options are active, which are changing the analysis
results. The Results group will clearly indicate this difference by displaying the
number of Total objects and the number of In Range objects.

Count Button

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Results Group

7. If the cell number labels displayed on the image are making it difficult to see the
cell outlines, the labels may be turned off.

To turn off the labels, select the Options Button in the Measurements Group.

Measurements Options Button
In the Labels Section of the Measurement Options dialog box set the text drop
down selection to “None.
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Measurements Options
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Chapter 4 Count objects and cells
Count cells in a monochrome image
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Chapter 4 Count objects and cells
Count cells in a monochrome image

8. Notice that some of the cells in the lower right hand part of the image are
touching. Count and Size has a number of splitting options which may be used
within the workflow to automatically split touching objects.

Select the drop down under the Split Button as shown below. At this step we are
working on setting the optimal splitting conditions.

In the center of the image, there are many touching nuclei. Choose the Boundary
Shape option and Split Objects with Count option. Press the Count Button and
see how the objects are split apart.

Setting Object Splitting Options
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Touching Nuclei

9. The Boundary based splitting still left a number of touching nuclei un-split.
Select the Watershed option and press the Count Button.
Is the splitting of the touching nuclei improved? If the nuclei are over split, use
the Ridge Size option to set an upper boundary limit in pixels to prevent over
splitting.
At this point, you can leave the Watershed split in place and continue onto the
next step.

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Splitting Options
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Chapter 4 Count objects and cells
Count cells in a monochrome image

10. Select Measurement/Types drop down to select the measurement parameters for
analysis.

Measurement List

Note: If the measurement you need is not selected, it will not be displayed in the
data table or be used for editing ranges.

11. To add measurements, highlight the measurement and click the Add Button or
double left click on the selection. Since the Measurements were reset in the
beginning of this exercise, please click on the Clear Button to remove all
measurements. For this exercise, add the following parameters:

Object: Class Name
Region: Area

Region: Diameter Mean
Region: Intensity Mean
Region: Roundness
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Chapter 4 Count objects and cells
Count cells in a monochrome image

Measurement Types
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Chapter 4 Count objects and cells
Count cells in a monochrome image

12. Select Measurement/Edit Range Button to adjust the measurement exclusion
(gating) parameters using the histogram.

Edit Range Button

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 4 Count objects and cells
Count cells in a monochrome image

13. Select the Region: Area measurement and adjust the histogram sliders to remove
the smallest particles. If the Active and Apply on Close check boxes are not
checked, do so now. As the sliders are adjusted to remove particles at the lower
and/or higher end of the range you will see the Objects in range value change.

Edit Measurement Range
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Chapter 4 Count objects and cells
Count cells in a monochrome image

14. Adjust the left slider to remove the smallest objects until you have approximately

504 nuclei in range as shown in the screen shot below.

Edit Measurement Range

15. Click on the Apply Filter Button to apply the settings. This operation may be
repeated for other measurement types on an as needed basis.

Click on the OK Button when completed.

16. When the Apply Filter Button is clicked, the filter range exclusions (gating) are
active as indicated by the highlighted Ranges Button in the Measurements

grouping.
Note: if the Ranges Button is toggled off at this point, the counted objects will
not change until the Count Button is pressed again.

Ranges Button is Active

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 4 Count objects and cells
Count cells in a monochrome image

17. Open the Options panel by pressing the Option Button in the Measurements

18.

19.

20.

group.

Measurements Options Button

The Options Panel contains options which will change the display of the objects
and labels, but also how the objects are counted.

Adjust the Font, Labels and Outlines options to see the effects of the different
options. These parameters will not affect how the nodules are counted.

Set the Count and Segmentation Options as shown in the image below.

There are three changes to make in this part of the exercise which are different
than the default settings and are marked by arrows in the image below:

e (lean Boarders is set to All
e Textis set to None
e Widthis setto2

Introduction to Celleste™ Imaging Analysis Software User Guide



Chapter 4 Count objects and cells
Count cells in a monochrome image

Measurements Options

21. Close the Measurement Dialog Box and click on the Count Button.

22. Select View/Data Table Button to see the data if the table is not already displayed.

View Group
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Chapter 4 Count objects and cells
Count cells in a monochrome image

23.

24,

25.

26.

Measurement Table

Select View/Data Histogram based data view to view a data histogram

Select View/Object Window to see and scroll through the individual objects and
parameters.

Click on the Statistics Button to show the measurement statistical values. Click on
the Export to Excel " Button to export the data values.

Note: The Measurement Table is literally What You See Is What You Get
(WYSIWYG) when you export the data to Excel .

The Measurement Table display also contains the ability to generate different
data displays by using the Group and Statistics options in the Measurement
Table.

Measurement Table

For a future exercise, set the measurement table to show the data in the following
way using the Grouping Button drop down to select the options:

Collapsed
Totals set to Average
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Grouping Selection Options

27. Click on the Grouping Button.

Grouping Button

Data Display
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Count cells in a monochrome image
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Chapter 4 Count objects and cells
Count cells in a monochrome image

28. In the Measurement Group, click on the Save Measurement Options Button to
save your current settings as “Cell Count”.

Save Measurement Options

Saving Measurements Options File

The following group and measurement table settings are saved in the .iqo file:
Segment

Split

Measurement Types

View

Class

Measurement Table

The file can be loaded at a later time in normal operations or used in a macro to
apply exactly the same settings in an analysis

Note: Saving the Settings File is one of the most important things you can do in
Celleste™ to insure proper image analysis.
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Chapter 4 Count objects and cells
Adjust auto-threshold

Adjust auto-threshold

In addition to manually adjusting the auto-threshold by a specific gray level intensity
offset, there is another method to automatically adjust the auto-threshold value by a
bias offset. In essence, the auto-threshold method may be fine turned to the samples
being analyzed.

1. Delete the counted nuclei by pressing the double red X button in the Select
Group.

2. Click on the Bright Button to auto threshold the bright nuclei.

Bright auto-threshold results

3. Click on the Options Button in the Measurements Group.
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Chapter 4 Count objects and cells
Adjust auto-threshold

4. Select the Auto-threshold bias method drop down and select the Stand Deviation
option.

Auto-threshold bias control
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Chapter 4 Count objects and cells
Adjust auto-threshold

Standard Deviation Bias Option

5. Adjust the Standard Deviation up and then down to see the results. As with all
Measurements Options, this parameters will be save with the settings file (.iqo).

Adjusting the Standard Deviation offset
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Chapter 4 Count objects and cells
Adjust auto-threshold

Adjusted Threshold
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Develop smart segmentation

Objectives:

Develop image segmentation methods based on Smart Segmentation (i.e. pixel
classification).

Understand the Recipe and what it means when creating a segmentation method.
Create a recipe based on a set of images.
Learn how to optimize the Smart Segmentation Recipe.

Save and apply Smart Segmentation settings.

Set up smart segmentation for a single fluorescent channel image

1.

Open the ” A549_0.15um_Live_Dead_NBL_10X_Plate_R_p0_0_D07fOOd0.TIF”
image from the Celleste” Demo Images
\Live_Dead_Cell_Imaging_Kit_SKUR37601_and_NucBlue"'Live_SKUR37605
\A549\ A549 0.15um_Live_Dead_NBL_10X.2017-02-08-17-48-35 folder.

The nuclei are labelled with NucBlue™ and will give a total cell count. The image
used in this example contains nuclei with a wide range of intensities, which
makes intensity based segmentation difficult.

Press the Measurements and Class Reset Buttons to clear any old values.

Reset Button

Introduction to Celleste™ Imaging Analysis Software User Guide 57



58

Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

3. Select the Count/Size Tab and press the Smart Segmentation button in the
Segment group.

Smart Segmentation Button
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

4. Press the Reset buttons in the Select and Count, and Recipe Options sections.

Smart Segmentation Panel

Note: Itis good practice to reset the Smart Segmentation feature and Count/Size
features when you are developing a new image analysis protocol or workflow.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

5. In the Recipe Options Section, press the All button to select all of the channels
used in the pixel classification.

Recipe Options Section

6. In the Select and Count Section of Smart Segmentation, name Class 1 “Nuclei”
and set the color to red.

a. Press the drawing tool button and draw the first class (bright fluorescence)
covering a representative area or object (Reference Object) belonging to the
class. Due to wide range on intensities, select a dimly labeled nucleus first.

b. Different selection tools may be selected from the drawing tool drop down.
However, the initial reference objects should be based on defining enclosed

areas and not based on a line or point.

The selection process should start with one reference area or object. The
segmentation may be updated after the first segmentation pass.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

Name Selection Tool

2 Selection Tool (Active)

Introduction to Celleste™ Imaging Analysis Software User Guide
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

Segmentation Example

7. Select the Background selection tool and draw a representative area on the
image. The background area can be any area in the image, as long as it is not the
same as any of the classes you wish to measure.

Once a single background region is created, the segmentation process will begin.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

Segmented Nuclei

8. If the results are not optimal, more areas may be selected on the image to
represent the different classes.

Additional background selections may also be created to help separate the
sample from the background. In the image as shown above, an additional
background area will need to be defined.

Note: If it is hard to see the sample underneath the segmentation overlay, you
may change the overlay transparency by using the Show button and selecting the
drop down control as shown below. Alternately, you may toggle the Show button
on/off. The Show button must be on or the segmentation will not proceed.

Mask and Overlay

Note: As soon as another Reference Object or Background Object is created on
the image, a new Smart Segmentation (classification) process will begin. This step
may be repeated as required.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

9. Place your mouse cursor over the Save Button to see the Recipe values.

Recipe Values
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Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

10. At this point, the segmentation step is complete and the image may be analyzed
using Count/Size in the normal way by setting Measurement Types, Splitting,
and Data Tables options.

Set the following Measurements Types
a. Split Objects with Count: On and the method set to Watershed

b. Measurement Types: Object: Class Name, Region: Area, Region: Diameter
Mean, Region: Intensity Mean and Region: Roundness

¢. Measurement Options: Set Labels Text to None and Clean Boarders to All

Measurement Types

Introduction to Celleste™ Imaging Analysis Software User Guide 65



Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

Measurements Options
When the analysis is satisfactory save and name the Measurment Options

settings file. Please call the file “Cell_Count_SmartSeg”. The .iqo file saves
how the analysis is set up, including the segmentation step. We will use this

file in the macro writing exercise.

Introduction to Celleste™ Imaging Analysis Software User Guide

66



Chapter 5 Develop smart segmentation
Set up smart segmentation for a single fluorescent channel image

Save Measurement Options

Recipe 1. Use as few Reference Objects as possible to define your classes.
optimization

suggestions 2. Be precise where you draw your reference areas. Select only what should be in

the class.

3. Use as few recipe channels as required to accurately segment your areas or
objects of interest. The fewer channels you use, the faster the segmentation step.

4. After determining the # of channels giving the best segmentation by using the
Top feature, press the Filter Button to remove all other channels not being used.

Note: If you will be developing a recipe based on multiple images, perform the
filtering channels step after the recipe is fully developed as shown in Part C of
this exercise.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes (e.g. stains or multi-channel fluorescence)

Removing Unused Channels

Set up smart segmentation for multiple object classes (e.g. stains or
multi-channel fluorescence)

1. From the Celleste ' Demo Images, select the IHC/Tissue folder and open the
“Imagel 4x.jpg” image.

2. Press the Measurements and Class Reset Buttons to clear any old values.

Reset Button
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes [e.g. stains or multi-channel fluorescence/

3. Select the Count/Size Tab and press the Smart Segmentation button in the
Segment group.

Smart Segmentation Button

Introduction to Celleste™ Imaging Analysis Software User Guide

69



70

Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes le.g. stains or multi-channel fluorescence/

4. Press the Reset buttons in the Select and Count, and Recipe Options sections.

Smart Segmentation Panel

Note: Itis good practice to reset the Smart Segmentation feature and Count/Size
features when you are developing a new image analysis protocol or workflow.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes [e.g. stains or multi-channel fluorescence/

5. In the Recipe Options Section, press the All button to select all of the channels
used in the pixel classification.

Recipe Options Section

6. In the Select and Count Section of Smart Segmentation, name Class 1
“Hematoxylin”.

7. Press the drawing tool button and draw the first class (Blue/Purple area)
covering a representative area or object (Reference Object) belonging to the class.
Set the color to green.

a. Different selection tools may be selected from the drawing tool drop down.

The selection process should start with one reference area or object. The
segmentation may be updated after the first segmentation pass.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes (e.g. stains or multi-channel fluorescence)

Name Selection Tool

8. Add second class by pressing the Add Class button. In the Select and Count
Section of Smart Segmentation, name Class 2 “DAB”.

Set the class color to red.

9. Name the Class 2 “DAB” and draw a representative area or object (Reference
Object) belonging to the class.

2 Selection Tool (Active)
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes [e.g. stains or multi-channel fluorescence/

Segmentation Example

10. After all classes have been selected, choose the Background selection tool and
draw a representative area on the image. The background area can be any area in
the image, as long as it is not the same as any of the classes you wish to measure.

Once a single background region is created, the segmentation process will begin.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes (e.g. stains or multi-channel fluorescence)

11.

Segmented Tissue

If the results are not optimal, more areas may be selected on the image to
represent the different classes.

Additional background selections may also be created to help separate the
sample from the background. In the image as shown above, an additional
background area will need to be defined.

Note: If it is hard to see the sample underneath the segmentation overlay, you
may change the overlay transparency by using the Show button and selecting the
drop down control as shown below. Alternately, you may toggle the Show button
on/off. The Show button must be on or the segmentation will not proceed.

Mask and Overlay

Note: As soon as another Reference Object or Background Object is created on
the image, a new Smart Segmentation (classification) process will begin. This step
may be repeated as required.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes [e.g. stains or multi-channel fluorescence/

12. Place your mouse cursor over the Save Button to see the Recipe values.

Recipe Values

13. At this point, the segmentation step is complete and the image may be analyzed
using Count/Size in the normal way by setting Measurement Types, Splitting,
and Data Tables options.

Set the following Measurements Types parameters and press the Count Button
when done.

a. Split Objects with Count: Off

b. Measurement Types: Object: Class Name, Region: Area, Region: Percent
Area (%)
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes (e.g. stains or multi-channel fluorescence)

c. Measurement Options: Set Labels Text to None.

Measurement Types

Measurements Options

When the analysis is satisfactory save and name the Measurment Options
settings file. Please call the file “Liver Smart”. The .iqo file saves how the
analysis is set up, including the segmentation step. We will use this file in

the macro writing exercise.
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Chapter 5 Develop smart segmentation
Set up smart segmentation for multiple object classes [e.g. stains or multi-channel fluorescence/

Save Measurement Options

Recipe 1. Use as few Reference Objects as possible to define your classes.
optimization

suggestions 2. Be precise where you draw your reference areas. Select only what should be in

the class.

3. Use as few recipe channels as required to accurately segment your areas or
objects of interest. The fewer channels you use, the faster the segmentation step.

4. After determining the # of channels giving the best segmentation by using the
Top feature, press the Filter Button to remove all other channels not being used.

Note: If you will be developing a recipe based on multiple images, perform the
filtering channels step after the recipe is fully developed as shown in Part C of
this exercise.
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Chapter 5 Develop smart segmentation
Update a recipe based on an image training set.

Removing Unused Channels

Update a recipe based on an image training set.

Smart Segmentation contains a special feature, which allows the segmentation settings
to be developed by using a set of training images. In many cases, one image is not
representative of all of the images to be analyzed in the experiment and the Train/Save
feature overcomes this issue.

1. From the Celleste ' Demo Images, select the IHC/Tissue folder and open the
“Image?2 4x.jpg” and “Image 3 4x.jpg” images.

Image Set
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Chapter 5 Develop smart segmentation
Update a recipe based on an image training set.

2. Make Image 1 4x.jpg the active image and confirm the segmentation layer is
displayed on the image.

3. If the image has been counted, delete the count.

4. Click on the Smart Segmentation button and the segmentation will be shown on
the image.

Segmented Tissue Image
5. Press the Set Global button in the Train and Save section. The segmentation

recipe from the active image is now the active segmentation and can be applied
to other images and tested.

Train and Save

6. Select Image3 4x.jpg and press the Apply Global button. This action will apply
the current Smart Segmentation recipe to the active image.
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Chapter 5 Develop smart segmentation
Update a recipe based on an image training set.

7. Review the image segmentation and draw new reference objects or background
areas as needed to refine the recipe. Draw only one object and wait for the
segmentation to update. Highlighting the Save button will indicate that new
reference objects have been created on the active image.

8. If the Recipe is acceptable, Press the Set Global button.

9. Select Image 2 4x.jpg and repeat Steps 6 and 7 as needed.

To use the new Recipe, count the image and save the Measurement Options
settings file (.iqo) as previously shown.
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Count multiple classes of objects

Objectives:

* Understand the workflow for setting up automated image analysis of
monochrome or color images when analyzing multiple classes of objects, cells, or
areas that are separated into individual classes through
segmentation/thresholding.

* Set up the Grouping option in the Measurement Table to display the
measurement values for each class.

Measure areas

1. From the Celleste ' Demo Images, select the IHC/Tissue folder and open the
“Imagel 4x.jpg” image. The image contains two distinctly stained tissue types.

2. Select the Count and Size Tab.

3. Reset Count/Size to default settings.

a. Reset Measurement and Class groups by pressing the reset button in each
group.

b. Turn off the Ranges button if it is active.

Count/Ribbon
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Chapter 6 Count multiple classes of objects

Measure areas

4. In the Segment group, press the Manual Button to launch the Threshold Tool
Panel. The color model selection allows the segmentation of the stained tissue
areas based various color models and channels.

Threshold Tool

5. Select the HSI color and H (Hue) channel as shown below.
Edit the Class Name and call it DAB. In addition, the segmentation color should
be adjusted to a color different from the stain colors on the image.

Segment the brown DAB areas by adjusting the eyedropper. Use the histogram to
make fine adjustments as required. If you make a mistake, simply press the undo
button.

Note: In general, it is easier to use the histogram sliders for monochrome
images. For a color image is easier to start with a particular color channel and use
the eye dropper. The slider can then be used to make adjustments if needed.

The eye dropper size may also be adjusted by setting the eyedropper size option.
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Hue Selection
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Chapter 6 Count multiple classes of objects
Measure areas

6. Press the Add New Segmentation Class Button to create Class 2 and name it
Hematoxylin. Use the eyedropper to segment the blue stained area.

Add New Segmentation Class Button

Hematoxylin Threshold
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Chapter 6 Count multiple classes of objects

7. Press the Count Button to see the results.

Before Count

Post Count Overlay

8. Set the following Measurement Types:
Object: Class Name
Region: Area
Region: Percent Area (%)

Introduction to Celleste™ Imaging Analysis Software User Guide

Measure areas

85



86

Chapter 6 Count multiple classes of objects
Measure areas

Measurement Types

9. The Measurement Table is capable of displaying the results by the class of
objects. Select the Grouping Button drop down and set the Totals to Sum and
Show Collapsed active.

Grouping Options
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Chapter 6 Count multiple classes of objects
Measure areas

10. Select the drop down again and select the Group by Class option. Click on the
Group Button if the table is not displayed as shown below.

Measurement Results

11. The Statistics view of the data may also be used to set and view statistics per
group (class) of objects, cells or areas. Select the Statistics Button drop down and
select the Setup Group Statistics.

Press the Statistics Button to show the group statistics.
When the data is exported to Excel ', the data is exported in WYSWYG.

Statistics Group Options
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Chapter 6 Count multiple classes of objects
Measure areas

Statistical Data View

12. Save the Measurements Options (.iqo) file and give it a relevant name.

Saving the Measurement Options
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Use the Wound healing and Parent-
Child (“Counting objects within
objects”) Apps

Objectives
* How load an App.
¢ Run the Wound Healing App.
* Run the Parent-Child App.

Use the Wound healing app

Celleste " includes two Apps that must be loaded in order to use them

1. Select the Apps Tab and press the Open Project Button.

Apps Tab
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Wound healing app

2. Select the WoundHealing.ipx file and open it.

Loading the Wound Healing App

3. The Wound Healing App is now loaded.

Loaded Wound Healing App
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Wound healing app

4. Click on the Wound Healing App Button to launch the App.

Wound Healing App
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Wound healing app

5. Open the” beacon 65 run two.wmv” image from the Celleste” Demo
Images\ Wound Healing folder.

Loading the Image File

6. The movie file and App are now ready to use.

Celleste™ Desktop
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Wound healing app

7. Click on the Test Segmentation Button to test the current threshold setting. The
Auto Threshold % may be adjusted higher or lower to correctly select the wound
area.

Test Segmentation Button
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Wound healing app

8. An outline around the wound area is displayed on the image. The Auto
Threshold % may now be adjusted and tested by clicking on the Test
Segmentation Button.
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Wound healing app

9. Select the Options and click on the Measure Wound Healing Button to run the
analysis.

Measure Wound Healing Button
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

Use the Parent-Child app

96

The application is designed to provide workflow for parent-child analysis
applications. The app allows the creation of parent-child projects which streamlines
the analysis and provides the complete set of relational data. In this exercise, you will
count the # of spots in each nucleus.

The images for this exercise will be handed out during the training session.

1. Select the Apps Tab and press the Open Project Button.

Apps Tab
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

2. Select and Open the ParentChild.ipx file located in the ParentChild folder.

Opening the Parent-Child App

3. Click on the Parent Child App button in the Apps Group to load it.

Loading the Parent-Child App
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

Parent Child App
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

4. There are 4 groups of controls exposed in the App:

5. The image pair consists for a Hoechst " labelled nuclei (Parent) and Alexa 488
marker for DNA damage (Child).

Image Pair

6. Reset Project using the Reset Button.

7. Select the Hoechst " to make it the active image.
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

8. Click on the Set Button in the Parent Image section.

Set Parent Image

9. Click on the Segment Button and select Smart Segmentation in the Count/Size
Tab.

10. Reset the Count/Size Measurements and Class Groups, including Smart
Segmentation.
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

11. Name the Class as Nuclei and use the All version of the Recipe Options as shown
below.

12. Use Smart Segmentation and the Count/Tools to segment the nuclei.

Note: These steps are setting up a workflow on how to correctly count the nuclei
(Parent Objects) and all Count/Size settings are active.
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

Object Splitting

13. Use the Count Button in the Parent Image group. Once you are satisfied the
nuclei are correctly counted or as well as can be accomplished, the Count
operation will create a settings file associated with the Parent Image group and
will be saved with the project file if one is saved at the end.

Counted Nuclei
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

14. Select the Alexa 488 image to make it the active image and click on the Add
Button in the Children section.

Children Group

15. Click on the Alexa 488 image and then click on the Segment Button in the
Children section.

Selecting the Segment Button

16. Click on the Segment Button and select Smart Segmentation in the Count/Size
Tab.

17. Reset the Count/Size Measurements and Class Groups, including Smart
Segmentation.

18. Name the Class as Foci and use the All version of the Recipe Options as shown
below. For this particular image, there is one important change to the Recipe due
to high background in the Alexa 488 which obscures the foci.

A Custom Channel will be added to help distinguish the foci from the
background.
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

Adding a Recipe New Channel

19. Under the Custom Button, select Add a new channel.

20. Select the Top Hat PLUS™ Filter and set the values to 5 for the Height and Width
as shown in the screen shot below.

For this image, a little image processing is necessary to separate the foci from the
background.

Adding a Custom Recipe Channel
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Chapter 7 Use the Wound healing and Parent-Child (“Counting objects within objects”) Apps
Use the Parent-Child app

21. Select the foci and background as normal by defining the reference areas on the
image. Use the rest of the Count/Size settings to properly count the foci. Press the
Count Button in the Children section to count the foci.

22. Click on the Combine Button. The Grouping in this section should be set to
Parent + Class.

Combining the Measurements

23. The results and image overlays are now displayed.

Results
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General workflow

Perform a 2D deconvolution

Objectives

Load a multi-well data set

Review the image meta data summary information

Setting up 2D Blind (Adaptive PSF) and Fixed PSF deconvolution
Understand the basic 2D deconvolution options

Launch the deconvolution process

Run a deconvolution batch process on selected wells

. Load the data set

Adjust image display in needed using Best fit or other image display tools
Launch the 2D deconvolution feature

Select well(s)

Confirm metadata settings

Select deconvolution settings

Select PSF settings

Start the deconvolution of the selected well(s) or image(s)

Set up 2D deconvolution setup

106

1.

Load the Live Dead image data set from the Live Dead Multiwell images folder
on the computer desktop, by selecting the Celleste” File/Open Images menu and
browsing to any “R” image in the Live Dead folder.

Check or tick the Group Related File option as shown in the screen shot below
and press the Open button.

The entire multi-well data set will now be loading into Celleste .
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup

2. Select Well position B2 and B3 by left mouse clicking on the well position B2 and
dragging over well position B3 in the Plate Viewer.
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup

3. If the images are too dim, press the Best-Fit button. If the individual image
channels need to be adjusted, select the channel and adjust the image display
settings by using the sliders as shown in the right-side screen shot below.

4. Select the Process Tab and press the 2D Deconvolution button located in the
Deconvolution group.
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup

5. Review the Metadata section of the 2D Deconvolution panel. If any information
is missing or incorrect, update the information before proceeding.

110 Introduction to Celleste™ Imaging Analysis Software User Guide



Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup

6. Select the deconvolution method by choosing the radio button selection. For this
part of the exercise, select the Adaptive PSF (Blind) method.

7. Set the PSF Setting to Theoretical PSF as shown below.

Note: Measured PSF Option: requires an image of a fluorescently labeled bead
acquired under the same image acquisition conditions.

Theoretical PSF Option: the PSF is mathematically generated based on the
metadata for the image set.

Derived PSF Option: the PSF is based on the image and is mathematically
calculated. In circumstances where the metadata may be unknown or suspect,
the image may still be deconvolved.
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup

8. Set Use Default Deconvolution Settings to ON, which is the default state. The
default Deconvolution Settings options should only be changed if the
deconvolution results are not satisfactory.
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Chapter 8 Perform a 2D deconvolution
Set up 2D deconvolution setup

9. Press the Launch button to deconvolve the images from the selected well
position.

10. Review the results
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Chapter 8 Perform a 2D deconvolution
Process batch deconvolution batch

Process batch deconvolution batch

The Celleste " v5.0 2D deconvolution feature will batch process all selected wells
when the Launch button is pressed.

1. Using the current data set, use a combination of the left mouse and the Shift key
to select a group of well positions or the Control key with the left mouse to select
several individual wells to deconvolve.

For this exercise use the left mouse and Shift key combination to select wells C1
through C3.

2. Using the previous deconvolution settings from Exercise 1 Part A, press the
Launch button in the 2D Deconvolution panel to deconvolve the selected wells.
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Perform a 3D deconvolution

Objectives

General workflow

Load a multi-channel fluorescent image z-stack

Review the image meta data summary information

Set up 3D Blind (Adaptive PSF) and Fixed PSF deconvolution
Understand the basic 3D deconvolution options

Launch the deconvolution process

Load the data set

Adjust image display if needed using Best fit or other image display tools
Launch the 3D deconvolution feature

Select well(s) or image set

Confirm the metadata settings

Select deconvolution settings

Select PSF settings

Start the deconvolution of the selected well(s) or image(s)

Set up 3D deconvolution

1.

116

™,

Load the EVOS 20X Kidney stack.2019-01-07-21-27-04 data set, by selecting the
Celleste " File/Open Images menu and browsing to any “R” image which

contains z-position information in the EVOS 20X Kidney
stack.2019-01-07-21-27-04 folder.

Check or tick the Group Related File options as shown in the screen shot below
and press the Open button.
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Chapter 9 Perform a 3D deconvolution
Set up 3D deconvolution

The multi-channel image data set will be loaded into Celleste . Use the slider or
image sequence player to move through the image stack.
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Chapter 9 Perform a 3D deconvolution
Set up 30 deconvolution

2. If the images are too dim, press the Best-Fit button. If the individual image
channels need to be adjusted, select the channel and adjust the image display
settings by using the sliders as shown in the screen shot on the right side below.
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Chapter 9 Perform a 3D deconvolution
Set up 3D deconvolution

3. Select the Process Tab and press the 3D Deconvolution button located in the
Deconvolution group.
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Chapter 9 Perform a 3D deconvolution
Set up 30 deconvolution

4. Review the Metadata section of the 3D Deconvolution panel. If any information
is missing or incorrect, update the information before proceeding.
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Chapter 9 Perform a 3D deconvolution
Set up 3D deconvolution

5. Select the deconvolution method by choosing the radio button selection. For this
part of the exercise, select the Adaptive PSF (Blind) method.

6. Set the PSF Setting to Theoretical PSF as shown below.

Note: Measured PSF Option: requires an image of a fluorescently labeled bead
acquired under the same image acquisition conditions.

Theoretical PSF Option: the PSF is mathematically generated based on the
metadata for the image set.
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Chapter 9 Perform a 3D deconvolution
Set up 30 deconvolution

7. Set the Use Default Deconvolution Settings to on, which is the default state. The
default Deconvolution Settings options should only be changed if the it the
deconvolution results are not satisfactory.

The Enable GPU processing will also be turn on by default if Celleste detects
both the nVIDIA graphics card and the CUDA libraries.

122 Introduction to Celleste™ Imaging Analysis Software User Guide



Chapter 9 Perform a 3D deconvolution
Set up 3D deconvolution

8. Press the Launch button to deconvolve the image stack.

9. Review the results
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Chapter 9 Perform a 3D deconvolution
Display the 3D volume

Display the 3D volume

The although 3D volume rendering is a later exercise and will require the 3D
Visualization Module for optimal results, the deconvolved 3D z-stack may now be
display as a 3D rendered volume.

1. Using the current deconvolved multichannel z-stack, press the 3D view button
located in the bottom right hand corner of the Celleste™ desktop.

An alternative method to generate the 3D image display is to select the Image tab
and press the 3D button. The image will now be displayed as a 3D volume.

2. Select the 3D View tab and set the parameters as shown below.
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Visualize an image

Objectives

* Learn how to set up and adjust the 3D viewing parameters for fluorescent or
color image z-stacks using the 3D Visualization Module

Set up image visualization

1. If the deconvolved Kidney data set is still open from Exercise 2, please use the
data set for this exercise.
If not, please follow the directions below using the previously saved
deconvolved Kidney image stack.
Load the E10_EVOS 20X Kidney stack _Top Slide_R.MCS file by selecting the
Celleste™ File/Open Images menu and browsing Deconvolved 20x Kidney image
folder located on the computer desktop

2. The z-stack is from the Molecular Probes" Slide #3 labeled Kidney section. Press
the play button on the Image Sequence Player to view the slices in the z-stack.
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Chapter 10 Visualize an image
Set up image visualization

3. Select the Image tab and press the 3D View button to convert the image into a 3D
rendered view. You may also select a 3D view short cut button from the bottom
right hand side of the Celleste 3D desktop, as shown in the second image.

4. Select the 3D View tab, if it not the active tab.
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Chapter 10 Visualize an image
Set up image visualization

5. The Blend composition is selected by default. Since this is fluorescently labeled
tissue, the Blend option will not optimally display the image. Next, try the Max "
Intensity, Sum, and Minimum Intensity options. After viewing the options, select
the Maximum Intensity option.

6. The Number of Slices slider sets the number of planes in the volume view.
Depending on the graphics card in the computer, the number of slices may be
increased to improve the image. For the best visualization display, set the
number of slices to 1024.
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Chapter 10 Visualize an image
Set up image visualization

7. If dealing with large volumes, it may be necessary to reload the volume using the
Volume Reload button located in the Input group to improve performance
setting the subsampling to a higher value.
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Chapter 10 Visualize an image
Set up image visualization

8. The current Celleste " default 3D viewing mode is set to Medium. The default
may be changed if required and is located under the File/Options/3D View

Options menu.

9. Adjust the Transparency slider, located in the View group, which is used to
improve the contrast for viewing segmented objects inside the sample. A setting
of 0% is a reasonable choice for this sample before counting.

Note: The rendered volume may be repositioned by holding down the Ctrl
(Control) key and dragging the image around on the Celleste " desktop when the

View Navigation setting is active.

10. The contrast may be further improved by changing the background color. Select
the Background drop-down and make your color selection.

For this exercise, set the background to black.
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Chapter 10 Visualize an image
Set up image visualization

11. Image quality may be further enhanced by using a pixel volume interpolation
between planes. Linear Interpolation is on by default. In addition, Cubic
Interpolation and/or the Pre-Integrated option may be turned on to improved
image quality. However, the results and rendering speed are dependent on the
graphics card and image size/volume.

Try the various options to view performance changes on your system, if any.
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Chapter 10 Visualize an image
Set up image visualization

12. Edge contrast may also be improved using the Boundary Opacity and Edge
Color options. Each Button must be toggled in the ON position to be active. Use
the drop-downs to select each option.

The options will not be used for this exercise

13. Image details may be further refined using the lighting options. Using the
Deferred Lighting option reveals a higher degree of detail with sharper
boundaries.

The option will not be used for this exercise.
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Chapter 10 Visualize an image
Set up image visualization

14. In the 3D View panel on the right side of the Celleste™ 3D desktop, adjust the
channels individually or all at same time using the Spread spin buttons or slider.
The Spread controls are the same as a histogram and you are setting the B/W
points.

The Histogram control is available by toggling on the Show Channel Histogram
button as shown below for the GFP channel. The Opaque Control allows you to
set the opacity of the voxels. (spread = histogram)

Opacity settings show pixels as opaque or transparent. Adjust the settings for
each channel.
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Chapter 10 Visualize an image
Set up image visualization

15. The 3D Viewer Channel control contains additional features to

a. show or hide a channel by clicking on the Eye button,
b. toggle a channel blinking by clicking the Traffic Light button and

c. set the channel color by color or dye by using the Palette controls.
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Chapter 10 Visualize an image
Set up image visualization

The ability to turn image channels on or off will become important during the
image analysis tutorial in order to enable better visualization of the segmentation
volume.
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Chapter 10 Visualize an image
Set up image visualization

16. Save your 3D settings using the Save button which is in the Volume Display
group. In general, the Rendering Options (*.ren) file version should be chosen in
most cases. The *.ren file will save the setting from both the 3D View and 3D
Measure tabs. The file is equivalent to the 2D *.iqo Measurement Options file. For
macro writing, the *.ren file is the correct file to use.

The *.s3d file saves not only the *.ren parameters but also a copy of the image.
Use the File/Open command to open *.s3d files.
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Work with 3D segmentation and
surfaces

Objectives

Load a multi-well data set

Review the image meta data summary information

Setting up 2D Blind (Adaptive PSF) and Fixed PSF deconvolution
Understand the basic 2D deconvolution options

Launch the deconvolution process

Run a deconvolution batch process on selected wells

Create the Iso-Surface

136

1.

The exercise will use the scan.2017-12-15-11-10-46-40x 0.95 image set located in
the scan.2017-12-15-11-10-46-40x 0.95 Stack folder on the image desktop.

Select and R image with z information and turn on the Group Related Files
option. Press the Open button to load the image stack.
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Chapter 11 Work with 3D segmentation and surfaces
Create the Iso-Surface

2. Press the 3D view button located in the bottom right hand corner of the Celleste
desktop to generate the 3D image.

An alternative method to generate the 3D image display is to select the Image tab
and press the 3D button. The image will now be displayed as a 3D volume.
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Chapter 11 Work with 3D segmentation and surfaces
Create the Iso-Surface

3. Adjust the image display as needed.
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Chapter 11 Work with 3D segmentation and surfaces
Create the [so-Surface

4. To create a solid iso-surface, select the Add Iso-Surface Button in the 3D View
Control Panel using the drop down control as shown below.
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Chapter 11 Work with 3D segmentation and surfaces
Create the Iso-Surface

5. After you press the Add Iso-Surface Button, the Add Iso-Surface dialog box will
be display as shown. Select the DAPI channel. A name for the object of interest
may be entered in the Name section. For this exercise, enter the Name as Nuclei.

Based on your computer system, you may need or desire to change from Auto
Subsampling default to a specific sampling rate. To change the sampling rate,
uncheck the Auto box option and either press the reset button for (1x1x1) or
choose a specific rate.

If the performance rate is not optimal, a higher rate of subsampling may be used
in order to have a reasonable system performance.
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Chapter 11 Work with 3D segmentation and surfaces
Create the [so-Surface

The other options include:

Filter: The various filters will perform object smoothing if required.

Threshold Type: The option is setting the auto segmentation type. For
example, if you objects or areas are bright, set the Drop Down to Auto
Bright. For this exercise, set the type to Auto Dark.

Close Edges: If the option is active, any object touching the edge of the
image will have a solid edge.

Execute Count: An automatic count will be performed based on the
Threshold Type setting. For this exercise, leave the option unchecked.

Auto Split: Auto Split operation using a 3D Watershed filter.

Ridge Size: Maximum size of ridges in voxels to be separated. The use of this
option will aid in preventing the over splitting of touching objects.

Precision: the iso-surface has an option for voxel or sub-Voxel precision

Clean Boarders: Any counted object touching the outside edge of the image
border will not be counted.

6. Press the OK Button when done.

7. To improve the contrast between the image and the segmented objects, use the
Color Drop Down to set the isosurface color.
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Chapter 11 Work with 3D segmentation and surfaces
Create the Iso-Surface

In addition, the Channels may be turned off to show only the areas of segmented
voxels.
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Chapter 11 Work with 3D segmentation and surfaces
Create the [so-Surface

8. The segmentation may be refined by using the Volume Histogram.

Note: Lighting effects located in the 3d View/View style group may be turned
on/off to highlight iso-surface details.
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Chapter 11 Work with 3D segmentation and surfaces
Create the Iso-Surface
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Chapter 11 Work with 3D segmentation and surfaces
Create a Pseudo-Surface

9. Re-save your 3D setting (*.ren extension) using the Save 3D Settings Button. You
may overwrite the 3D settings file created in Exercise 3. This file will be used in
the following exercises.

Create a Pseudo-Surface

The Celleste " 3D Visualization Module includes a different type of surface which is a
pseudo-surface and is created by the Add Volume Measurement. The surface is
different from the iso-surface in several important ways:

* Up to 100x faster than iso-surface
* Counts holes/voids

* Ability to measure larger volumes
¢ Voxel based only

¢ Cannot be used with clipping planes
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Chapter 11 Work with 3D segmentation and surfaces
Create a Pseudo-Surface

1. Turn off the Volume Surface DAPI image.
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Chapter 11 Work with 3D segmentation and surfaces
Create a Pseudo-Surface

2. Using the BPEA image data set used earlier in this exercise, select the Add
Volume Measurements in the 3D View Control Panel.
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Chapter 11 Work with 3D segmentation and surfaces
Create a Pseudo-Surface

3. Select the DAPI Channel and enter the Name as Nuclei
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Chapter 11 Work with 3D segmentation and surfaces
Create a Pseudo-Surface

4. Turn off all image channels except the new volume Measurements DAPI image
to view the segmentation nuclei.
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Chapter 11 Work with 3D segmentation and surfaces
Create a Pseudo-Surface

5. Other image channels may be turned on/off as need to visualization purposes.
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Create clipping planes

Objectives
* How to create and use clipping planes to peel back the volume

* Set the order of clipping planes and isosurfaces in the 3D View

Add an ortho slice clipping plane

1. The exercise will use the scan.2017-12-15-11-10-46-40x 0.95 image set located in
the scan.2017-12-15-11-10-46-40x 0.95 Stack folder on the image desktop.

2. Press the 3D view button located in the bottom right hand corner of the Celleste
desktop to generate the 3D image.

An alternative method to generate the 3D image display is to select the Image tab
and press the 3D button. The image will now be displayed as a 3D volume. Select
the Image tab and press the 3D View Button to convert the image into a 3D
rendered view.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

3. Load your .ren setting file from Exercise #4.

4. In the 3D View Ribbon set the following parameters if they are not already set:
¢ Composition Group: Maximum Intensity Projection

¢ Composition Group: # of Slices to 1024

5. To aid in moving the 3D rendered volume image around, select the Projections
Icon drop down and select the Wheel options.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

6. In the 3D View Control panel on the right side of the desktop, the settings from
Exercise 4 should be like the screen shot below with all channels on the nuclei
isosurface displayed.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

7. Press the Add Ortho Slice Button located in the 3D View Control Panel.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

8. Set the isosurface display to off by left mouse clicking on the Eye icon in the
Nuclei isosurface control as shown in in the screen shot below. In a later part of
the exercise the Nuclei channel will be turned on.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

9. To see how the settings parameter, update the image display, set the Orientation
to the X Plane and tilt the object slightly forward as shown below. In addition to
the orientation, set the Type to Transparent and then to Opaque. This control sets
the clipping plane display.

Figure 1 Ortho Slice Controls

10. Next, adjust the Slice number sider to move the clipping plane back and forth.

11. Finally, turn the Clipping on by pressing the Clipping Plane button. Use the
Clipping drop down to adjust the direction.

Adjust the various Ortho Slice controls to become familiar with them and how
they change the image display.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

12. Add another Ortho Slice and set the Orientation to Y. Turn on the Clipping Plane
and set the Front or Back option to be able to clip the sample form the X and Y
direction.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

13. Turn on the Nuclei iso-surface to see the nuclei channel.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

14. The Ortho Slice contains various types of views for looking through the slice. The
Opaque setting will display a solid view of the image along the slice.

The Type view also includes support for a Transparent view with a control to set
the % transparency. This feature will be useful later to view the isosurface of
counted objects.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

15. Celleste also includes a Oblique Slice tool to view a sample from different
angles.

16. The order of the Ortho Slices in relation to the isosurface in the 3D control panel
will make a difference on whether the iso-surface will be left intack or clipped by
the Ortho Slice.

Left mouse click on the first Ortho Slice and drag it above he Nuclei channel. A
black insertion bar will appear when you in the correct location.

The X Ortho Slice will clip the nuclie and the Y Ortho slice will not clip the nuclei
as shown in the screen shot below.
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Chapter 12 Create clipping planes
Add an ortho slice clipping plane

17. Save the 3D settings for later use. From the 3D View Ribbon, press the Save 3D
Settings Button located in the Volume Display Group as shown below.

Enter a File Name and press the Save Button. The file is saved as a Rendering
Options *.ren file.
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Work with 3D animations and movie
making

Objectives
* Learn how to create animations from 3D objects
* Learn how to edit animations to enhance visualization

* Learn to export movies for sharing

Create simple animations

In this section we will use the preset options built into Celleste " for creating simple
animations and then add manual camera positions to highlight specific features of
interest.

1. The exercise will use the scan.2017-12-15-11-10-46-40x 0.95 image set located in
the scan.2017-12-15-11-10-46-40x 0.95 Stack folder on the image desktop.

M

2. Press the 3D view button located in the bottom right hand corner of the Celleste’
desktop to generate the 3D image.
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Chapter 13 Work with 3D animations and movie making
Create simple animations

3. Load the .ren file from Exercise 5 using the load file button located in the 3D
View/Volume Group.

4. Turn off all ortho slice and isosurface channels in the 3D control panel on the left.
Only the 3-fluorescent channels should be displayed.

5. Select the 3D Animation tab and look for the Animation Path group in the
ribbon. You will see the predefined path animations available in Celleste™: spin,
fly around and rock the object as well as the option to set custom rotations.
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Chapter 13 Work with 3D animations and movie making
Create simple animations

6. Depending on the computer, image size and complexity of the animation, the
recording phase may be sped up by resetting the volume display to an increased
subsampling rate. The recording will play back faster as the animation is edited.
Before producing the movie, the volume display can be set back to the desired
image resolutions.

7. First, try a 360° spin. Click on the drop-down and you will have the option to
choose which axis and which direction to spin the 3D view. Choose one and the
Timeline will appear with the original view as a key frame and each intermediate
position along the rotation added as well.
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Chapter 13 Work with 3D animations and movie making
Create simple animations

8. An animation has been created and may be played using the image sequence
playback controls.

9. To return to the original position click the Fast Rewind button.
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Chapter 13 Work with 3D animations and movie making
Create simple animations

10. To add more positions to an animation you can simply manually rotate the object
and/or change the zoom level then click the button to Add Camera Position from
the Frames section of the ribbon.

11. Add three more positions changing views and zoom levels and see how the
animation evolves.

12. Under the Options section you will also find some checkboxes for Advanced
Animation, Connect Start-End and Sync with Time. We will look at the
Advanced™ Animation option later, but for now, if you want to be able to play
through the animation as a loop you should use the Connect option. In that case,
Image-Pro will automatically insert interstitial frames to connect the last and first
key frames for an animation that smoothly repeats from the end back to the start.
If your set were to contain multiple time points, you could use the Sync option to
play through the time points at the same rate as you play through camera angles.
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Chapter 13 Work with 3D animations and movie making
Create simple animations

13. When we've finished the complete animation path we can export this as a movie
that can be played in media players or integrated into presentations. To do this,
click on the Movie button in the Output section of the ribbon.

14. The playback frame rate of the movie you created is dependent on the FPS
number you had prior to producing the movie. You can manually change this
before you produce your movie for faster or slower playback with the same
number of frames, but you can also change this in the Sequence Playback
Options.
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Chapter 13 Work with 3D animations and movie making
Edit the timeline

Edit the timeline

In this section we will look at how you can manually speed up, slow down or
rearrange the order of specific transitions to customize custom animations.

1. As we saw in the previous exercise, adding camera positions and animations
creates what we call a timeline of camera positions with key frames and
interstitial frames to complete the animation. If we’ve added a key frame by
mistake, we can start by simply deleting this frame. To do this, select the key
frame from the Timeline by clicking on it or select from the Key numeric
up/down box in the Frames section of the ribbon then click the Delete button to
remove it.

2. If the key frame is still needed, but just the camera position is not quite right, it
may be easier to replace this frame with a new updated camera position. To do
this, select the key frame as before, then adjust the camera position and click
Replace Camera Position.
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Chapter 13 Work with 3D animations and movie making
Edit the timeline

3. Adding camera positions key frames also adds interstitial frames to go from one
key frame to the next. The relative number of interstitial positions changes how
quickly or smoothly the animation goes from one key frame to the next. To
change the default number of interstitial positions, click on Options and you will
find the option to change the number of interstitial frames for freeform
animations and also for circular animations that we used earlier. Try changing
these numbers and adding more key frames or animations.
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Chapter 13 Work with 3D animations and movie making
Edit the timeline

4. Now, as before, we may find that we’ve added key frames, but afterwards realize
that the pace is not quite correct and we might want to add or remove interstitial
frames. This can be done in two ways. First, using the interface in the timeline
you will see that key frames have a blue handle on the top. If you click and drag
that handle left or right you will reduce or increase the number of interstitial
frames for this portion of the animation.

5. Alternatively, you can select a key frame using the Key numeric up-down of the
ribbon to select the key frame for the portion you want to modify, and then
increase the Inter number immediately below that.
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Chapter 13 Work with 3D animations and movie making
Add iso-surfaces and slices manipulations to the animation

6. To quickly adjust the smoothness of animation for the entire sequence, use the
Double All or Halve All buttons in the ribbon to double or halve the number of
frames.

Add iso-surfaces and slices manipulations to the animation

In this section we will look at how you can add additional elements to an animation
and adjust their position and/or rendering effects to reveal complex elements of the
structure.

Animations as we’ve seen above allow for a thorough examination of the structure of
the model, but it does not necessarily allow you to adequately expose structures that
might be more easily seen with iso-surfaces or slices. Using the Advanced
Animation we can not only add or remove objects using key frames, we can also
transition the positioning or rendering of these objects.

1. First let’s clear the workspace by deleting all previous animation elements. To do
this, click Clear from the Frames section of the ribbon and then turn on the
Record Rendering Setting from the Options section of the ribbon.
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Chapter 13 Work with 3D animations and movie making
Add iso-surfaces and slices manipulations to the animation

2. Record an initial position.

3. Turn on the Nuclei isosurface in the 3D control panel, turn the image slightly and
record the position.

4. Turn on Ortho Slice 1, move the sample slightly and record the position.
5. Adjust the Ortho Slice 1 slice position and record.

6. Finally, create a movie of your animation and save the result to AVI.
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Perform 3D analysis

Objectives
* Learn how to set up an automated analysis workflow.

* Save and load a settings file for future use.

Count objects

1. The exercise will use the scan.2017-12-15-11-10-46-40x 0.95 image set located in
the scan.2017-12-15-11-10-46-40x 0.95 Stack folder on the image desktop.

2. Press the 3D view button located in the bottom right hand corner of the Celleste
desktop to generate the 3D image.

3. Load the .ren file from Exercise 5 using the load file button located in the 3D
View/Volume Group.
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Chapter 14 Perform 3D analysis
Count objects

4. Turn off all fluorescent and ortho slice channels in the 3D control panel on the
left. Only the isosurface should be displayed.

5. In this example, the nuclei have been previously segmented. Adjust the
segmentation histogram to fully segment the nuclei.

6. Select the 3D Measure tab.

7. 3D automated object and volume measurements are similar in concept to 2D
analysis in Celleste . The first step is to select the measurement parameters for
analysis. Use the Drop Down under the Types icon to select the Volume
parameters, located in the Volume Measurements Group.
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Chapter 14 Perform 3D analysis
Count objects

8. By default, measurement parameters have been placed in the Selected
Measurements/Filters as shown in the image below. From the Available
Measurement select and add the following parameters to the Selected
Measurements/Filters: Sphericity, Area of Surface and Surface Name.

The Lines based measurement parameters will not be used and may be removed
if desired.

9. Press the Count button.

10. Open the Data Table by clicking the button located in the View group.
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Chapter 14 Perform 3D analysis
Count objects

11. The Edit Range feature may be used to remove counted particles which are not
nuclei. Any or a combination of parameters may be used to gate out unwanted
objects.

To gate objects by Volume, select the Volume parameter and use the histogram
sliders to remove unwanted objects.

Turn on the Apply on Close option and press the OK button.

12. Press the Count button to recount.

13. Select the 3D Options button located in the Volume Measurements group.

The 3D Option controls contains setting for setting counted object text and how
the counted objects are color coded. The Coloring option may be set to Random
or Parent. If Parent is chosen, the objects will retain the color of the isosurface.
This is important if you have more than one segmentation class of objects.
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Chapter 14 Perform 3D analysis
Count objects

14. Additional object counting options may be accessed when the isosurface or
volume measurement is created. If either surface has already been created, press
the Gear icon located in the isosurface channel control.

The Gear icon will relaunch the surface creation dialog box. Close Edges, Auto-
Split and Clean boards are applied to the counting operation from this dialog
box.
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Chapter 14 Perform 3D analysis
Count objects

15. Once the 3D the analysis settings/protocol is correct, you should save your
settings if you plan to perform a similar analysis later, or plan to use macros with
these settings. To save your settings, select the 3D View ribbon. Press the Save 3D
button and enter in a File Name appropriate for your sample or analysis.

The 3D *.ren file saves both the 3D Rendering and the 3D Measurement
automated analysis settings.
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Analyze multi-well plate data using
the Live/Dead cells app

Objectives:
* Load the Live/Dead Cells App
¢ Configure the App
* Analyse Multi-well plate data
¢ Export the Data

Analyze multi-well plate data using the Live/Dead cells app

1. From the “File” menu select the application options (which you find at the
bottom right of the File menu).

2. In the Image options ensure that “Auto Tile” is selected.
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Chapter 15 Analyze multi-well plate data using the Live/Dead cells app
Analyze multi-well plate data using the Live/Dead cells app

3. Open one of the Raw Images from the “Live Dead” dataset. Ensure group related
files is selected.

The dataset will open with the plate viewer displayed in the details panel on the
right of the application.

4. Make well A5 the active well.

5. Select the “Apps” tab.

6. Click “Open Projects” and select the LiveDeadCells.ipx (this is located in the
default scripts folder (C:\Users\<Current User>\ Documents \ Celleste "

5\Scripts\ LiveDeadCells).

7.  Click on the Live/Dead Cells icon on the Apps ribbon.

8. Set the kit to “Custom” and click on the option to “Read channel names from the
active image.
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Chapter 15 Analyze multi-well plate data using the Live/Dead cells app
Analyze multi-well plate data using the Live/Dead cells app

9. Set the Total drop down to the DAPI channel, and the Live Drop down to the
GFP channel.

10. Click Start Experiment.

11. The App will display the Segmentation options for the Dapi channel and ask you
to set a threshold that separates nuclei from the background. Click Ok in the “Set
Thresholds” dialog when you are finished.
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Chapter 15 Analyze multi-well plate data using the Live/Dead cells app
Analyze multi-well plate data using the Live/Dead cells app

12. Click on the “Adjust measurement area interactively” button to access the Edit
Measurement Range dialog. Set upper and lower limits for nuclei area.

13. Set the Auto-Split option to the most appropriate setting and select Clean
Borders if appropriate.

14. Click Next SegmentationGFP.

15. Select appropriate segmentation settings for GFP repeating the workflow that
you implemented for the DAPI channel.

16. Click Next Results.

The data collector is populated with results. You have the option to save the
annotated results image or the experiment template.
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Chapter 15 Analyze multi-well plate data using the Live/Dead cells app
Analyze multi-well plate data using the Live/Dead cells app

17. We are interested in analysing the entire plate so click finish.

18. Set the active range of the plate to Row A or B.
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Chapter 15 Analyze multi-well plate data using the Live/Dead cells app
Analyze multi-well plate data using the Live/Dead cells app

19. Deselect the Interactive option and select the Batch mode option.

20. Click Run Experiment. The whole plate will be analysed.
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Chapter 15 Analyze multi-well plate data using the Live/Dead cells app
Analyze multi-well plate data using the Live/Dead cells app

21. Export the data to excel.

22. Close the dataset and reopen it with auto-tiling deselected. Re-run the
experiment. In what way is the data generated different? Which option is best?
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Learn classification

Objectives:
* Set up a classification scheme to determine if a cell is alive or dead

¢ Understand potential uses of Learning Classification

Learn classification

1. From the Celleste ' Demo Images location, select the Ready Probes Cell Viability
BandG SKU R37609/ hela_BG_low folder and open
hela_BG_low_Plate_R_p00_0_A08f01d0.TIF and
hela_BG_low_Plate_R_p00_0_A08f01d1.TIF images.

The blue nuclei in the d0 image will give the total cell count.
The green nuclei in the dlimage will give the dead cell count.

Demo Images
2. Select the Count and Size Tab.

3. Press the Measurements and Class Reset Buttons to clear any old values.

Reset Button

4. Select the hela BG_low_Plate_R_p00_0_A08{01d0.TIF image and make it the
active image.
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Chapter 16 Learn classification
Learn classification

5. Use Smart Segmentation to segment the nuclei.

Smart Segmentation

6. Set following Count and Size parameters:
a. Split Objects with Count: On using Watershed

b. Measurement Options: Set Labels Text to None and Clean Boarders to All
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Chapter 16 Learn classification
Learn classification

7. Measurement Types: Object: Class Name, Region: Area, Region: Intensity Mean
and Region: Standard Deviation

Measurement Types

8. Adjust Edit Range to remove non-nuclei fluorescent areas in the image. Press the
Count Button when done.

9. Save the Measurements Options (.iqo) file and name it Total Cell Count.

Save Measurements Options
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Chapter 16 Learn classification
Learn classification

10. Open Features Manger located in the Select Tab. If the Features Manger is
hidden, right mouse click in the Select Ribbon and turn it on.

Features Manager

11. Clear any data in Features Manager and add the nuclei outlines to Features
Manager as a New collection.

Adding a New Collection of Measurement Features

Introduction to Celleste™ Imaging Analysis Software User Guide 189



Chapter 16 Learn classification
Learn classification

Nuclei Measurement Qutlines

12. Select the hela_BG_low_Plate_R_p00_0_A08f01d1.TTF image and make it the
active image.
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Chapter 16 Learn classification
Learn classification

13. Press the Set Feature to Image Button to transfer the nuclei outlines to the d1
active image.

Transfer Nuclei Outlines

14. Select the Count/ Size Tab.

Introduction to Celleste™ Imaging Analysis Software User Guide 191



Chapter 16 Learn classification
Learn classification

15. Press the Learning Classification Button in the Classify Group.

Learning Classification
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Chapter 16 Learn classification
Learn classification

16. Press the Add Class Button. Rename Class 1 to Live Cells.

Adding a Class of Objects
Press the Select Reference Objects Button.

Naming and Selecting Reference Objects
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Chapter 16 Learn classification
Learn classification

17. Select one or two Live Cells which do not contain any fluorescence from the d1
green image. Press the OK Button when done.

Adding Reference Objects
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Chapter 16 Learn classification
Learn classification

18. Press the Add Class Button and add another class. Rename Class 2 and name the
class Dead Cells.

Adding a Second Class of Objects

19. Press the Select Reference Objects Button and add reference objects that are
positive for fluorescence from the d1 image.
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Chapter 16 Learn classification
Learn classification

20. In Section 3, press the Add All Button to select all measurements as shown in the
screen shot below.

Selecting Classification Measurements
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Chapter 16 Learn classification
Learn classification

21. In Section 4, press the Calculate Classifiers Button.

Calculating the Weights of Classification Measurements

22. The nuclei are classified and color coded

Classified Nuclei

23. Press the Data Table Button in the View Group if the Measurement Table is not
displayed.
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Chapter 16 Learn classification
Learn classification

24, Select the Grouping drop down in the Measurement Table and set the Totals to
Average and set Show Collapsed as active.

Set Measurements Table Display

25. Press the Grouping Button to display the collapsed data table.

Data Results
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Measure colocalization

Objectives:
* Learn how to measure colocalization between to markers in an image.

* Learn how to measure colocalization between to markers on a per cell basis

Measure colocalization

1. From the Celleste"' Demo Images location, select the Colocalization-ER & Golgi
folder and open the two images ending in d1 and d3. The Green Channel is d1
and the Red Channel is d3.

Colocalization Demo Images
2. Select the Measure Ribbon
3. Select the d3 image to make it the active image.

4. Select the Drop Down under the Colocalization Create Button. Since only two
images are open, the active image is automatically assigned as the first image
and the second image is assigned to as the second image.

Set the following options:
Parent Image: None
Color Pair: Red-Green
Result Type: Color
Threshold: Auto-Bright
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Chapter 17 Measure colocalization
Measure colocalization

Colocalization Setup

5. Click on the Create Button. The colocalization results are reported in the data
table and are based on the threshold settings. The sliders may be used to adjust
the minimum intensity threshold per channel to set the intensity level above
background or on some other user basis.

The areas of colocalization are show in white.
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Chapter 17 Measure colocalization
Measure colocalization

Colocalization Results
The image colocalization display be may be toggled on/off to show the Red,
Green and colocalized areas or to show only the colocalized areas by pressing the

Multi-Channel Mask Button.

Multi-Channel Mask Button
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Chapter 17 Measure colocalization
Measure per cell- or region-based colocalization

Measure per cell- or region-based colocalization

Celleste " includes the ability to manually define regions for colocalization analysis or
to use the Count/Size tools to segment cells or structures of interest in order to
perform colocalization in these areas.

The following exercise will use manually defined regions for use in colocalization

analysis.

1. Close the Colocalization panel.

2. The exercise will use the same images from Part A. The Green Channel is d1 and
the Red Channel is d3.

3. Select the Measure Ribbon
4. Select the d3 image to make it the active image.

5. Select the Drop Down under the Colocalization Create Button. With two images
now open, the active image is automatically assigned as the first image and the
other image is assigned to as the second image.

Colocalization Setup

Set the following option:
Parent Image: None
Color Pair: Red-Green
Result Type: Color
Threshold: Auto-Bright
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Chapter 17 Measure colocalization
Measure per cell- or region-based colocalization

6. Press the Create Button. The colocalization results are reported in the data table
and are based on the threshold settings. The sliders may be used to adjust the
minimum intensity threshold per channel to set the intensity level above
background or on some other user basis.

The areas of colocalization are show in white.

7. Under the Define Parent Outline section of the Colocalization panel, set the
Method to Manual Region.

Defining Parent Outlines

8. From the Direct Group in the Measure Ribbon, select any enclosed region such as
the Polygon Tool to define the regions or cells to analyze colocalization.

Draw the regions on the colocalized image. The Show Button may also be
toggled off to hide the colocalized areas in order to more clearly see the image
while drawing the regions.
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Chapter 17 Measure colocalization

Measure per cell- or region-based colocalization

Polygon Tool

9. After all of the regions have been defined and the colocalized areas are displayed
on the image, click on the Add Measure Button in the Image Colocalization
Results section. The per object data will be sent to the measurement table as

Measurement Table:

) M a: .| BT . % B
8= E
Ll 74941 Red 0.50 066 0.8 138 069 0.99 095 0391 1.00 033
(@ P2 534.94 Red 0.57 012 0.97 013 129 0.85 1.00 032 082 1.00
@ 3 97515 Red 043 0.76 099 0.58 169 0.52 099 047 049 1.00
& P5 977.25 Red 013 0.63 0.36 074 1.25 0.85 053 077 051 1.00

Measurement Table
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Set up Data Collector

Objectives:

Set up Data Collector for accumulating data from multiple images
Collect statistical information from each image

Set up the collection of Class statistics and parameters

Save the Data Collector Table for later use

Create your own equations (Optional)

Set up Data Collector

For this part of the exercise, you will use the nucleus images from Chapter 4, “Count
objects and cells” and the Measurements Options settings file.

1.

Open the ” A549_0.6um_Live_Dead_NBL_10X_Plate_R_p0_0_DO07f00d0.TIF”
image from the Celleste” Demo Images

\Live_Dead_Cell_Imaging_Kit_SKUR37601_and_NucBlue "Live_SKUR37605
\A549\ A549 0.6um_Live Dead_ NBL_10X.2017-02-08-17-48-35 folder.

Select the Count and Size tab.

Load the Measurements Options file (.iqo) you created in Chapter 4, “Count
objects and cells”. The file should be named “Cell Count”.
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Chapter 18 Set up Data Collector
Set up Data Collector

4. Please note the loading the .iqo file only loads all of the settings and does not
automatically count the image. Click on the Count Button.

Counted Nuclei

5. Select the Measure Tab.

6. Click on the Data Collector Reset Button to clear out any previous settings.

Data Collector Group
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Chapter 18 Set up Data Collector
Set up Data Collector

7. Press the Types Button in the Data Collector Group. Since the image is already
counted, by resetting Data Collector and opening the Types, Data Collect will
load all current measurement parameters from the Count/Size tool.

Data Collector Types

8. Close the Types panel and click on the Collect button.

Collect Button
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Chapter 18 Set up Data Collector
Set up Data Collector

9. Click on the Data Table button in the Data Collector group.

Note: By default, the Data Table will not be displayed until the button is pressed.
When analyzing a large number of images, the table should not be displayed
until the analysis is completed. If the table is displayed, the table will recalculate
the statistical results each time data is added. This process can be time
consuming when you are counting thousands or tens of thousands of objects per

image.

Data Table Button

Data Collector Results

10. The Data Collector Table has now accumulated the data. Every time the Collect
button is pressed, data from the Measurement Table will be sent to Data
Collector.

208 Introduction to Celleste™ Imaging Analysis Software User Guide



Chapter 18 Set up Data Collector
Set up Data Collector for accumulating statistical information

Set up Data Collector for accumulating statistical information

Data Collector has the ability to collect and retain specific statistical information. In
addition, the setup of the Types can be saved for later use in other experiments and/or
be used in batch processing routines.

The follow steps will set up the Data Collector Types table to collect only statistical
information for a single class of object.

1. Delete the current data from Data Collector data table by pressing the double red
X Remove All button.

Remove Data
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating statistical information

2. Click on the Data Collector Types button again. Under the Available
Measurements on the left side, use the drop down to select the Measurements
provider. For this exercise, only the Data Provider: Measurements will be used.
Select the Measurements provide from the drop down as shown.

Data Collector Types

3. The exercise will use the Table: Measurement Stats parameters. Toggle the little
widget next to Table: Measurement Stats to expand the list of parameters.

Measurement Stats
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating statistical information

4. Select the Display Name in the Measurement Stats section on the left side and
press the Add button. The Display Name will report the actual image name in
the data table in order to keep track of which image the data was generated from.
Notice there is now a table called Table: Measurement Stats under the Selected
Measurements group on the right hand side.

Selecting Display Name Parameter

5. From the Measurement Stats section, add the Object: Class Name.

For all other measurement types, a specific sub parameter will be chosen. Add
the Region: Area type and select the specific Count parameter from drop down
list in the center column to keep track of the number of cells per image.

Adding a Measurement Type Sub Parameter
Add the following parameters:

Object: Class Name

Region: Area/Count

Region: Diameter Mean/Mean
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating statistical information

Region: Intensity Mean/Mean
Region: Roundness/Mean

Selected Measurements

6. Uncheck every box on the right side, except those under Table: Measurement
Stats. Only the actively checked parameters will be displayed in the Data
Collector Table.

Note: Do not remove any parameter from the Selected Measurement if they
were added at the time of the reset. Some statistical parameters are calculated
from the Measurement data in Data Collector. If the parameter is not available to
Data Collector, the statistical information will not be calculated.
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating statistical information

Selected Measurements

7. Close the Measurement Types Table.
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating statistical information

8. Click on the Collect Button and display the Data Table. Every time the Collect
button is pressed, the data from the active image will be sent to Data Collector. It
the Automatic Collect feature is active, the data will be sent to Data Collector
automatically.

Measurement Statistics

9. Click on the Save button in the Data Collector Group and save the Data Set file.
For this example, name the file “Cell Summary”.

Data Collector Save As

Additional images may now be counted and the Data Collector Collect Button
pressed after each image is counted to accumulate the data.

In addition, the data may automatically be sent to the Data Collector by turning
on the Automatic Collection Button. When the Automatic Collection feature is
active, data will be sent to Data Collector every time the Count Button is pressed,
even if the image has already been counted.
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Set up Data Collector for accumulating Multi-Class statistical information

Set up Data Collector for accumulating Multi-Class statistical
information

The follow steps will set up the Data Collector table to collect only statistical
information per each class object. In this exercise, you will use the image and settings
files from Chapter 5, “Develop smart segmentation”.

1. From the Celleste"' Demo Images, select the IHC/Tissue folder and open the
“Imagel 4x.jpg” image. This is the stained liver tissue.

2. Select the Count/Size Tab.
3. From the Measurements Group, load the Measurements Options (.iqo) settings

file for analyzing the liver tissue using Smart Segmentation. The file should be
named Liver Smart.

Loading Measurements Options .iqo File
4. Click on the Count Button to analyze the image.

5. Delete the current data set from the Data Collector data table by pressing the
double red X Remove All button.

Introduction to Celleste™ Imaging Analysis Software User Guide 215



Chapter 18 Set up Data Collector
Set up Data Collector for accumulating Multi-Class statistical information

6. Click on the Data Collector Reset Button to clear out any previous settings.

Data Collector Group

7. Press the Types Button in the Data Collector. On the left side under the Available
Measurements, toggle the widgets to collapse the Data Providers as shown. For
this exercise, only the Data Provider: Measurements will be used.

8. Expand’ the Table: Measurement Class Stats section by toggling the widget for
this section.
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating Multi-Class statistical information

9. Select the Display Name in the Measurement Class Stats section on the left side
and press the Add button. Notice there is now a table called Table: Measurement
Class Stats under the Selected Measurements group on the right hand side.

Adding a Measurement

10. Select the Class Name in the Measurement Class Stats section on the left side and
press the Add button.

11. Select the Region: Area measurement in the Measurement Class Stats section on
the left side. Use the drop down area in the middle column to select the Sum
parameter and then press the Add button.

For most measurements, specific statistical parameters may be collected in order
to generate the information required for the experiment.

Statistical Parameter Selection

12. Select the Region: Percent Area (%) measurement in the Measurement Class Stats
section on the left side. Use the drop down area in the middle column to select
the Sum parameter and then press the Add button.

The Selected Measurements should look like:
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating Multi-Class statistical information

Selected Measurements
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating Multi-Class statistical information

13. Uncheck every box on the right side, except those under Table: Measurement
Class Stats. Only the actively checked parameters will be displayed in the Data
Collector Table.

Selected Measurements
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Chapter 18 Set up Data Collector
Set up Data Collector for accumulating Multi-Class statistical information

14. Click on the Collect and Data Table Buttons to view the results.

Results per Class

15. Save the Types table by pressing the Save button in the Data Collector group.
Name the table “Liver Stats”.

Data Collector Group

Additional images may now be counted and the Data Collector Collect Button
pressed after each image is counted to accumulate the data.

In addition, the data may automatically be sent to the Data Collector by turning
on the Automatic Collection Button. When the Automatic Collection feature is
active, data will be sent to Data Collector every time the Count Button is pressed,
even if the image has already been counted.
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[Optional] Create a custom equation

Automatic Collection Button

[Optional) Create a custom equation

1. Open the ” A549 0.6um_Live_Dead_NBL_10X_Plate_R_p0_0_D07f00d0.TIF”
image.

2. Load the Cell Count.iqo file from Chapter 4, “Count objects and cells”.
3. Count the image.

4. Reset the Data Collector Types.

5. Press the Collect button.

6. Press the Types button to see the current measurement types.
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Chapter 18 Set up Data Collector
[Optional] Create a custom equation

7. Press the New Button

Adding A Custom Equation

8. Set the Table to Measurement. Create an equation such as 1/Roundness as
shown. Optional: create your own equation.

9. Type the number 1 in the Expression followed by a division sign.
10. Select the Region: Roundness in the Variable and press the Green Insert Button.

11. Add an equation name to the Caption section.

Building an Equation
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[Optional] Create a custom equation

Custom Equation Display.
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Track intensity

Objectives:

* Learn how to measure intensity changes over time using adherent cells

* Display various data views of the intensity changes per region

Create tracking regions

1.

™

From the Celleste” Demo Images location, select the Endocytosis-pHrodo
vesicles folder and the “Endocytosis-pHrodo " vesicles.tif” image. The image is a

M

multi-tif time series and will play as a movie in Celleste™.

Note: If each time point image is a separate image, the individual images may
be opened automatically as a movie within Celleste . Use File/Open and go the
image folder containing the images. Select all of the images in the time series
using either Shift/Click or Control/Click. Check the Open As Sequence option as
shown below in the File Open dialog box and the images will open as a movie
within Celleste .

Open As Image Sequence Option

2. Select the Measure Tab.

3. Click on the Intensity Button in the Tracking Group.
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Tracking Group
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Chapter 19 Track intensity
Create tracking regions

4. A new Intensity Tracking Ribbon will be displayed in Celleste .

Intensity Tracking Ribbon

5. Press the Types Button in the Measurements Group.

6. Select the Region parameters needed for the experiment. Since the regions for
this type of analysis will be fixed, do not select any morphological parameter
since they will be the same for each time point.

For this exercise, select the following parameters:
Regions: Area

Regions: Intensity Blue

Regions: Intensity Green

Regions: Intensity Red

Measurement Types
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Chapter 19 Track intensity
Create tracking regions

7. Select the type of drawing object which will be used to analyze the cells.

Drawing Tools

226 Introduction to Celleste™ Imaging Analysis Software User Guide



Chapter 19 Track intensity
Create tracking regions

8. Draw the regions on the cells or areas of interest.

Defined Regions

Note: If you make an error in drawing the outline of the region, it is not
necessary to delete it and start over.

Press the Select Tracks Button and click on the cell outline to make it active.
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Create tracking regions

Select Button
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Chapter 19 Track intensity
Create tracking regions

Active Outline
With the outline active, right mouse click on the outline to display a tool set
containing the Poly Nudge Tool as shown in the image below.

Poly Nudge Tool
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Chapter 19 Track intensity
Create tracking regions

Select the Poly Nudge Tool Button and adjust the outline by holding down the
left mouse button while adjusting the outline. If you need a large or smaller tool,
use the wheel mouse to adjust the size of the tool.

Turn off the Poly Nudge Tool by a right mouse click to display the main tools
control and clicking on the Poly Nudge Tool Button to turn it off.

Adjusting the Region QOutline
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Chapter 19 Track intensity
Create tracking regions

9. The intensity tracking information is automatically calculated when the data is
displayed. Select the Data Table and Data Graph from the Data Views Group.

Data Views Group

Data Displays
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Create a macro

Objectives:

Create and name a Macro Project
¢ Record a macro performing a simple analysis

e Edit a macro to add user interactions

Plan a macro

1. Make a paper plan or flow chart of your processing/analysis workflow.
2. Manually walk through the steps before recording.

3. Save settings files (i.e. Count Size Measurements Options, Data Collector), which
will be used later if required.

4. Create a new Project. Use the default locations for settings files and macros.
5. Record your macro.

6. Test your macro.

Create a project

1. Open the ” A549_0.6um_Live_Dead_NBL_10X_Plate_R_p0_0_D07f00d0.TIF ”
image from the Celleste” Demo Images

\Live_Dead_Cell_Imaging_Kit_SKUR37601_and_NucBlue"Live_SKUR37605
\A549\ A549_0.6um_Live_Dead_NBL_10X.2017-02-08-17-48-35 folder.
This is the nucleus image from Chapter 4, “Count objects and cells”.

2. Select the Automate Tab.
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Chapter 20 Create a macro
Record a macro

3. Click on the New Project Button.

New Project Button

4. Enter in a Project Name, Module Name and check the Recording Target
Checkbox.

Project Name: Cell
New Module Name: Cell_Counting

New Project Dialog Box

Record a macro

1. Have the image open and not counted. We want to record the macro without
opening the image.

2. Close or minimize the Project Workbench.

Introduction to Celleste™ Imaging Analysis Software User Guide 233



Chapter 20 Create a macro
Record a macro

3. Select the Automate Tab and click on the “Record Macro” Button.

Record Macro Button

4. Enter the name of your macro: Count_Cells

5. Press the OK Button when done.

Record Macro Dialog Box

Note: Everything you do will be recorded from this point forward until you stop
the recording, however, you can pause a recording using the Pause Recording

button in the Recording window.

Macro Recording Control

6. Select the Count and Size tab.
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Chapter 20 Create a macro
Record a macro

7. From the Measurement Options group, load the saved Cell Count.iqo file. This
file will have the .iqo extension. The previously saved settings are now loaded
into Celleste .

Opening a Saved Measurements File
Note: If you have not saved a settings file and have started recording the macro,
you may pause the macro recording and create one at this point.

8. The settings are now loaded. Since we want to make the threshold set interactive
later, click on the Manual Button in the Segment Group. The Threshold Tool
dialog box will now be displayed.

Note: If you plan on making the Thresholding step interactive when the macro
runs, it simpler to have the dialog box open and available at the point. It will
make the later macro editing step easier.

Manual Threshold Button

9. Press the Count button to count the image.
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Chapter 20 Create a macro
Record a macro

10. If the Data Table is not displayed automatically after the Count operation, click
on the Data Table Button in the View Group to display the measurements table.

Measurements Table

11. Press the Stop Recording button.

Stop Recording Button

12. Press the Yes button to save the recorded macro.

Saving the Recorded Macro
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Chapter 20 Create a macro
Record a macro

13. View the recorded macro by clicking on the Project Workbench button.

Launching the Project Workbench

Recorded Macro
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Chapter 20 Create a macro
Play a macro

Play a macro

1. Delete the counted nuclei on the image.

2. Select the Automate Tab and select the recorded macro from the drop down
under the Project Explorer button as shown below. The macro will automatically
run when it is selected.

Playing a Macro

Add a user interaction step to a macro

There are two ways to make an operation interactive in the designer view:

* Method 1: If the operation is recorded in the macro, the command’s parameters
may be changed to make the step interactive.

* Method 2: The other option is to add a command to the macro through the use of
the Macro Toolbox and make the command interactive.

The exercise will use Method 2 of adding in commands through the use of the Macro
Toolbox.
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Chapter 20 Create a macro
Add a user interaction step to a macro

1. In the Project Workbench, the macro will be displayed in the designer view as
shown below. Each line contains properties related to the specific command.

Macro
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Chapter 20 Create a macro
Add a user interaction step to a macro

2. Select the Interaction scripting tool from the Toolbox as shown below.

Macro Toolbox
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Chapter 20 Create a macro
Add a user interaction step to a macro

3. Drag the Interaction Command and insert it between the Threshold and
Measurement Options lines in the macro as shown below. The macro is
automatically placed into an edit mode.

Adding an Interaction Command

4. With the Interaction line selected and highlighted, add the following text to the
Prompt and Text areas in the Properties panel as shown below.

Prompt: Adjust Segmentation and Press the OK Button When Done
Text: Adjust Threshold
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Chapter 20 Create a macro
Add a user interaction step to a macro

Adding Instructions

5. Set the Input to doc 1 using the drop down.

Setting the Input
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Chapter 20 Create a macro
Add a user interaction step to a macro

6. Right mouse click in the area next to the Record All Button and select the Prompt
User In Imaging Workspace option.

Making the Macro Interactive
7. Load the macro by pressing the Load button.

8. Run the macro from the Project Explorer drop down. The macro will now
prompt the user to adjust the threshold.

User Prompt
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Chapter 20 Create a macro
Add a macro to the quick access toolbar

Add a macro to the quick access toolbar

1. Open the Project Workbench view the macro in the designer view. Click on the
top level of the macro as shown below.

Cell Counting Macro
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Chapter 20 Create a macro
Add a macro to the quick access toolbar

2. In the Properties area, check the Quick Access box to turn it on. A macro icon
linked to this macro will now appear in the Quick Assess Toolbar.

Macro Properties

Quick Access Toolbar
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Create advanced macro

Objectives:
¢ Create and name a Macro Project
¢ Record a macro performing a simple analysis using Smart Segmentation
* Set up and use Data Collector in a batch processing mode

e Add user interactions to a macro

Plan a macro

1. Make a paper plan or flow chart of your processing/analysis workflow
2. Manually walk through the steps before recording.

3. Save settings files (i.e. Count Size, Data Collector), which will be used later if
required.

4. Create a new Project. Use the default locations for settings files and macros.
5. Record your macro

6. Test your macro

Create a project

1. From the Celleste” Demo Images, select the IHC/Tissue folder and open the
“Imagel 4x.jpg” image. This is the liver image with two stains.

2. Select the Automate Tab.
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Chapter 21 Create advanced macro
Create a project

3. Click on the New Project Button.

New Project Button

4. Enter in a Project Name, Module Name and check the Recording Target
Checkbox.

Project Name: Tissue_Project
New Module Name: Measure_Area

New Project Dialog Box
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Chapter 21 Create advanced macro
Record a macro

Record a macro

1. Have the test image open and not counted. We want to record the macro without
opening the image. The Batch Processing feature will take care of opening the
images from the folder.

2. Close the Project Workbench.

3. Select the Automate Tab and press the “Record Macro” Button.

Record Macro Button

4. Enter the name of your macro: Count_2Dyes.

5. Press the OK Button when done.

Record Macro Dialog Box

Note: Everything you do will be recorded from this point forward until you stop
the recording, however, you can pause a recording using the button in the
Recording window.
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Chapter 21 Create advanced macro
Record a macro

Macro Recording Control
6. Select the Count and Size tab.

7. From the Measurement Options group, open the saved “Liver Smart” file. This
file will have the .iqo extension. The previously saved settings are now loaded

™

into Celleste .

Opening a Saved Measurements File

Note: If you have not saved a settings file and have started recording the macro,
you may pause the macro and create one at this point.
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Chapter 21 Create advanced macro
Record a macro

8. Press the Count Button.

Count Button

9. Press the Stop Recording Button.

Macro Recording Control

10. Press yes to save your current project.

Save Project Dialog Box
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Chapter 21 Create advanced macro
Play a macro

Play a macro

1. Close the test image and reopen it.

2. From the Automate Tab, Select the Project Explorer drop down and choose your
macro. Confirm that the macro runs correctly.

Running a Macro

3. Delete the count when done and leave the image open on the desktop.
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Chapter 21 Create advanced macro
Add a user interaction step to a macro

Add a user interaction step to a macro

In this part of the exercise, we will add an interactive command to draw an ROI
around the tissue sections or areas of interest.

1. Select the Automate Tab and press the Project Workbench Button. The macro will
be displayed in the Designer Mode as shown.

Macro
2. In the Toolbox search area, enter ROL

3. Select the Polygon Tool and drag it to the beginning of the macro and drop it in.
By dragging the command into the macro, the Project has entered an editing
mode.
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Chapter 21 Create advanced macro
Add a user interaction step to a macro

4. Press the Yes button to save the changes.

Project Workbench

5. Highlight the Polygon Tool in the macro and edit the following properties in the
Properties Panel:

Input: docl
Prompt: Draw ROI around tissue of interest

Properties Panel
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Chapter 21 Create advanced macro
Add a user interaction step to a macro

6. Right mouse click on the Properties Panel and select the “Prompt User In
Imaging Workspace” option (Left Mouse Click to Select). Right mouse click again

to confirm the option is selected.

Properties Panel

7. Press the Load Button.

Project Group
8. Run the macro on the reloaded image.
9. Launch the Project Workbench.

10. Highlight the Excel” command in the macro by left mouse clicking on it.
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Chapter 21 Create advanced macro
Add a user interaction step to a macro

11. Right click and select the Delete option.

Deleting a Macro Command in Designer View

12. Press the Project Load button to save the changes.

13. Rerun the macro on the image to confirm the macro has been correctly changed.
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Chapter 21 Create advanced macro
Set up batching processing macros

Set up batching processing macros

This section of the exercise will record two macros to use in the Run Before and Run
After section of the Batch Processing Feature to collect the statistical information per
class for each image.

Record the run The Run Before macro will be used to set up Data Collector for use in the Batch
before macro Process feature. The macro will be recorded to accomplish the following:

* Place Data Collector into a known state for recording the macro.

Load the correct Data Collect settings file created in Chapter 17, “Measure
colocalization”

Delete any data current residing in the Data Collect Data Table
e Turn on Automatic data collection.

1. Select the Measure Ribbon.

N

From Chapter 17, “Measure colocalization”, the Data Collector group should
indicate the following;:

e There is data still in the Data Table.
e The Automatic Collection button is off.
¢ The Data Table is not display.

IMPORTANT! If this is not the case, please set the Data Collector group to this
state. If no data exists in the Data Table, rerun your Count_2Dye macro on the
tissue image and press the Collect button to send data to the data table.

Data Collector Group
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Chapter 21 Create advanced macro
Set up batching processing macros

3. Select the Automate Tab, press the Record macro button. Name the new macro:
“Setup_dc_liver”.

Record Macro Setup

4. Record the following steps in order:
a. Load the Liver Stats (.adoxsd) Data Collector Types file.

Load Button

b. Delete the stored Data Table measurement by pressing the double red x
button.
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Chapter 21 Create advanced macro
Set up batching processing macros

c. Turn on Automatic Collection by pressing the Automatic Collection button.

Automatic Collection Button

d. Stop recording the macro.
Recording the Run After Macro

The Run After macro will be used to turn off automatic data collection and
display the Data Collector Data Table.

5. Select the Automate Tab, press the Record macro button. Name the new macro:
“Close_dc_liver”.

Record Macro Setup

6. Record the following steps in order:
a. Turn off Automatic Collection.

b. Press the Data Table button to display the Data Collector Data Table.

c. Stop recording the macro.
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Chapter 21 Create advanced macro
Set up batching processing macros

Run a batch 1. Select the Automate Tab.

process _ )
2. Press the Batch Processing button in the Tasks Group.

3. In Section 1 of the Batch Processing dialog box, use the drop down selection in
each group to choose the correct macros:

Run Before: Setup_dc_liver
Loop On:Count_2Dyes
Run After: Close_dc_liver

Selecting the Macros
In Section 2, select the folder icon, not the drop down, and browse to the
Celleste™ Demo Images and select the IHC/Tissue folder.
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Chapter 21 Create advanced macro
Set up batching processing macros

Selecting an Image Folder

Selected Image Folder and Images
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Chapter 21 Create advanced macro
Set up batching processing macros

4. Set the Batch Process parameters as shown and press Start.

5. View the data results and export them to Excel .
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Perform 3D colocalization

Objectives

e Perform 3D colocalization image analysis on a multichannel data set.

* Save the settings files for future use or to record in a macro.

* How to analyze colocalization within a structure such as nuclei or tissue.
Note: this image is not from an EVOS'™ system and will be updated in the future.

However, the exercise will give an introduction on how to use the 3D Colocalization
feature in the 3D Analysis Module.
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Chapter 22 Perform 3D colocalization
Set up a 3D colocalization analysis

Set up a 3D colocalization analysis

1. Open the “ER+Ricin_Colocalization.mcs” image file by selecting the Celleste "
File/Open Images menu and browsing to file located in the Colocalization Images
folder on the computer desktop. The image is a dual labeled sample, however,
the image stack consists of 3 channels. Two of the channels are of the same probe
but taken using either confocal or STED imaging methods.

The experiment was a demonstration on how different imaging techniques may
influence the colocalization analysis results. In this experiment, the improved
resolution with STED allows for a more accurate representation of ricin’s
colocalization with the ER as evidenced when comparing ricin (green) and the
colocalization results (cyan and yellow) in both panels.

2. Select the Image tab and press the 3D View button to convert the image into a 3D

rendered view. You may also select a 3D view short cut button from the bottom
right hand side of the Celleste" 3D desktop, as shown in the second image.

3. Adjust the image display using the tools in the 3D View Ribbon. Please set the
3D View setting to the following:

a. Transparency: 0%
b. Background: Black

c. Composition: Max" Intensity Projection
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Chapter 22 Perform 3D colocalization
Set up a 30 colocalization analysis

d. # of slices: 1024

4. Turn off the STED-ER Channel.
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Chapter 22 Perform 3D colocalization
Set up a 3D colocalization analysis

5. Press the Add 3D Iso-surface Colocalization button as shown below.

Figure 2 Add 3D Colocalization
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Chapter 22 Perform 3D colocalization
Set up a 30 colocalization analysis

6. In the Add Iso-Surface dialog box, select the channel pair of “Confocal-ER, Ricin
Colocalization”. This action will select the image pairs for 3D colocalization
analysis.

Figure 3 Add Iso-Surface Dialog Box

7. Choose the level of volume sub-sampling based on the needs of the analysis and
computer capability. For this exercise use the default 2M voxel setting or Auto.
The sub-sampling is literally a sub-sampling of the original image data. To have a
full analysis of the image data, the X,Y,Z values should all be set to 1 if the
computer is capable.

8. Choose a filter if the sample is noisy or too much extraneous intensity

information is present in the image. Note, filtering will change the image
intensity information. For this exercise, set the filter to LoPass 3x3x3.
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Chapter 22 Perform 3D colocalization
Set up a 3D colocalization analysis

9. Set Threshold type to AutoBright. The threshold for each channel may be
adjusted using the intensity slider controls in a later step. For a 3D colocalization
analysis, only Auto Bright or Zero-Pearson thresholding method will be used
initially.

Figure 4 Threshold Options

10. Close edges should be checked and active, with rest of the options off as shown
below. Press the OK button when done.

11. Based on the threshold method, the colocalized voxels are displayed in the
rendered volume as an iso-surface.
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Chapter 22 Perform 3D colocalization
Set up a 30 colocalization analysis

12. In the Colocalization panel on the right, the Threshold Mode is the default
setting. The individual channel thresholds may be adjusted based on the
experimental protocol using the Red and Green channel sliders. As the intensity
threshold is adjusted, the colocalization results are automatically updated in
Section 2 Results.

Note: in order to understand which image channel in the colocalization pair
corresponds to the data, the first channel selected in the colocalization pair
corresponds to the Red channel and the second channel in the pair
corresponds to the Green channel.

Figure 5 Threshold Mode

The Mode may also be changed to Free ROI and the ROI adjusted directly on the
scatterplot. Once the threshold or Free ROI is completed, the data may be directly
export to Excel ', saved or included in a report using the tools in the Results
section.

After completion of this step, leave the image and data open. We will be using
the image and data in Part B of this exercise.
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Chapter 22 Perform 3D colocalization
Set up a 3D colocalization analysis

Figure 6 Free ROl Mode
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Chapter 22 Perform 3D colocalization
Set up a 30 colocalization analysis

13. Review the colocalization results and export the table for later comparison.
Please note the final threshold values for the Ricin channel. The same

segmentation values for the Ricin channel will be used when using the STED-ER,
Ricin pair for measuring colocalization.

Figure 7 Colocalization Data
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Chapter 22 Perform 3D colocalization
[Optional] Set up a 3D colocalization analysis, STED-ER and ricin

[Optional]Set up a 3D colocalization analysis, STED-ER and ricin

In this exercise, we will analyze the colocalization for the STED-ER and Ricin probes
and compare them to the Confocal-ER and Ricin probes.

1. Turn off the Confocal-ER and Colocalization Confocal-ER, Ricin Channels as
shown in the image below. Turn of the STED-ER Channel. Adjust the STED-ER
channel display in order to clearly see the fluorescence.

Figure 8 STED-ER Channel Display Turned On

Figure 9 STED-ER Channel Adjustment

Introduction to Celleste™ Imaging Analysis Software User Guide 271



Chapter 22 Perform 3D colocalization
[Optional] Set up a 3D colocalization analysis, STED-ER and ricin

2. Press the Add 3D Colocalization button and add the STED-ER, Ricin pair as
shown below.

Figure 10 Add Iso-surface colocalization pair.

3. Repeat Steps 6 on page 266-12 on page 268 from Part A of this exercise and
compare the results.
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Keyboard shortcuts

Objectives:

There are many keyboard shortcuts built into Celleste” Software to help you
perform common tasks quickly and easily.

General workspace shortcuts

1. <F1>=Get Help

2. <F11>=Full Screen Display

3. <Alt>+<F10>= Show/Hide Key tips

4. <Ctrl>=<Tab> = Go to next image/view
5.
6
7
8
9

<Ctrl> + <Shift> + <Tab> = Go to previous image/view

. <Ctrl> + <Y> or <Alt> +<Shift>+<Backspace> = Redo
. <Ctrl> + <Z> or <Alt> +<Backspace> = Undo

. <Ctrl> + <N>= New image dialog

. <Ctrl> + <O> = Open file dialog

10.
11.
12.
13.
14.

<Ctrl> + <P> = Print dialog

<Ctrl> + <S> = Save dialog

<Ctrl>+<Shift>+<Z> = during startup will reset the user settings and layout
<Alt>+ <F4> = Close application

<ALT> = displays tool bar shortcuts

Image or ROI (region of interest) shortcuts

1.

<Ctrl> + <X> or <Ctrl> + <Delete> = Cut (Cut the part of the image in the ROI onto
the clipboard.)

<Ctrl> + <C> of <Ctrl> + <Insert> = Copy (Copy the part of the image in the ROI
onto the clipboard.)

<Ctrl> + <V> or <Shift> + Insert> = Paste (Paste image from clipboard onto the
active image. If there is no active image, a new image will be created.)

<Ctrl> + <Shift> + <V> = Paste New (Paste image from clipboard into a new
image)

<Ctrl> + <Shift> + <C> = Crop (Crop the part of the image in the ROI into a new
image.)

Open the “Alstack.tif” image located in the File/Open/Open Demo Images/3D
Viewer folder location.
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Appendix A Keyboard shortcuts
Graphical object [ROI, annotations, measurements] shortcuts

Graphical object (ROI, annotations, measurements) shortcuts

Zoom shortcuts

Other controls

274

1.
2.

S o

<Ctrl> + <A> = Select all objects in the active overlay

<Ctrl> key while clicking the mouse will deselect any object.

<Ctrl> + <+>= Zoom in one step
<Ctrl> + <->=Zoom out one step
<Ctrl> + <0> = Zoom 100%
<Ctrl> + <1> = Scale Best Fit
<Ctrl> + <2> = Scale Width
<Ctrl> + <3> = Scale Height

Celleste" Software contains some additional controls which may not be obvious to you.
For example, in some cases, using the <Shift>, < Ctrl>, or <Alt> keys can modify the
behavior of various tools. If you press the <Shift> key when selecting an elliptical ROI
or annotation shape, Celleste Software will convert the ellipse to a circle. The same
applies for converting rectangles to squares.

If you're editing an existing line, you can increase the slope of line by 15 degrees by
selecting the line and the <Shift> key. There is also a feature to constrain the line to the
slope of the original line, so that the line can be extended from either end. The cursor
changes to make it obvious whether you're extending the line, or snapping to a

15 degree multiple.
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Calibrate an image

Objectives:
* Create a spatial calibration using the Auto Calibrate Wizard
* Create a spatial calibration using the Quick Calibration (Point to Point) method

e Link a Calibration to a Lens
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

Create a reference calibration using the calibration wizard

1. Open the "Micrometer 10x 20um bars.tif” image by selecting the File Tab,
Open/Open Demo Images menu and browse to the Additional Images. The
image is located in the Additional Images folder.

File Menu

Note: All demo images for the training class are in the Celleste” Demo Images
folder.
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

2. Right Mouse Click in the Home Ribbon and the Show or Hide Groups: Dialog
Box will be displayed as shown in the image below. The Calibration Group is
normally hidden by default in Celleste™.

Show or Hide Group Dialog Box

3. Select the “Auto Calibration” Button located in the Calibration Group.

Auto Calibration Button

4. Enter the values in for Calibration Name, Units (micrometer) and Distance (20).
Check the Reference calibration Check box. Finally, check the Show calibration
dialog Check box.

Note: if the reference calibration is not checked, the calibration will only exist in
memory and will be deleted when Celleste " is closed.
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

Auto Calibration Dialog Box
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

5. The image is now calibrated and the active calibration may be verified by
viewing the Spatial Calibration dialog box.

Marker Display

6. Delete the overlays by selecting the Select Tab and pressing the Double Red XX
Button in the Annotate Group.

Annotate Group Box
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

7. Place a new calibration marker on the image by selecting the Toggle Marker
Button if a Marker Bar is not on the image.

Toggle Marker Button Activated
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

8. To move the marker to a new location or change its display characteristics, select
the Spatial Calibrations Options drop down and chose the Marker Options as
shown in the screen shot.

Marker Options
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Appendix B Calibrate an image
Create a reference calibration using the calibration wizard

Spatial Calibration Options Drop Down Selections
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Appendix B Calibrate an image
Create a reference calibration using the quick calibration [Point to Point] method.

Create a reference calibration using the quick calibration (Point to
Point) method.

In this exercise will use the same image and create another 20x calibration using a
different name using the Point to Point calibration method.

1. Turn off the Toggle Marker Button.

2. Select Quick Calibration Button as shown and follow the instructions. You will
need to create a new calibration name or just overwrite the previous calibration

name.

Quick Calibration Instructions

3. The Local Zoom tool will automatically launch when using the Quick Calibration

Tool. It is useful to see where the calibration points are being placed without
having to zoom or magnify the original image.
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Appendix B Calibrate an image
[Optional] Link a calibration to a Lens/Objective

[Optional)Link a calibration to a Lens/Objective

If you are receiving images from a device on a routine basis and constantly need to
calibrate the images, you may link a lens to a specific calibration. This is a shortcut

and by passes the need to display the Spatial Calibrations dialog box each time you
need to access a commonly used calibration file.

1. Select the Lens Options from the Characteristics group box.

Lens Option Button
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Appendix B Calibrate an image
(Optional] Link a calibration to a Lens/Objective

2. Inthe Lens Library section of the Lenses dialog box, select the Olympus UPLFN
10X objective and check/tick the adjacent Check box to the objective.

Lens Library
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Appendix B Calibrate an image
[Optional] Link a calibration to a Lens/Objective

3. From the Name drop down, select your 10X objective. For this example, select the
Olympus UPLEN 10X.

Lenses Panel
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Appendix B Calibrate an image
(Optional] Link a calibration to a Lens/Objective

4. From the Calibration Drop Down, select the Olympus 10X calibration. The
calibration file is now linked to the lens/objective.

Lens Dialog Box
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Appendix B Calibrate an image
[Optional] Link a calibration to a Lens/Objective

5. When the correct Lens for an active non-calibrated image is selected in the
Optical Characteristics Group, the Apply Lens button will apply the calibration
to the image when the Apply Button is clicked.

Apply Lens Calibration to the Active Image
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Appendix B Calibrate an image
Apply a calibration to a non-calibrated image

Apply a calibration to a non-calibrated image

If you are opening an un-calibrated image in Celleste ", you may apply a saved
reference calibration to the image using an alternative method.

1. From the Celleste ' Demo Images, select the IHC/Tissue folder and open the
“Imagel 4x.jpg” image.

2. Open the Spatial Calibration Option Dialog Box by selecting from the Spatial
Calibration Options drop down selection or press the button.
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Appendix B Calibrate an image
Apply a calibration to a non-calibrated image

3. Use the Name drop down selection and choose the correct 10X calibration
previously created in this exercise. Click on the Apply button to apply the
calibration to the active image.

Spatial Calibration Options Dialog Box
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Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
e Worldwide contact telephone numbers
¢ Product support information
— Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
¢ Order and web support

¢ Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale at
www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you have
any questions, please contact Life Technologies at www.thermofisher.com/support.
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